Canon

RAW Image Processing, Viewing and Editing Software

Digital Photo Professional

Ver. 3.3

Instruction Manual

Content of this Instruction Manual

DPP is used for Digital Photo Professional.

In this manual, the windows used in the
examples are from Mac OS X 10.4.

» indicates the selection procedure of the menu.

Example: [Digital Photo Professional] menu »
[Quit Digital Photo Professional].

Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

** indicates a reference page.
Click to move to the relevant page.

"2 : Marks helpful information when a problem
arises.

\I@/

@ . Marks information that should be read

N
/TN

before use.

Marks additional information you may find
helpful.

. Marks tips for using the software skillfully.

& Switching Between Pages
Click on arrows on the bottom right of the screen.

(D : next page
€D : previous page

: return to a page you had previously
displayed

® Click on the chapter headings on the right side

of the screen to switch to the contents page of
that chapter. Also, click the item you want to
read about on the table of contents to move to
the relevant page.

Help and Shortcut Keys

For information about using DPP, refer to Help
from the [Help] menu.

Refer to the “Shortcut Key List” in the Help for a
list of shortcut keys which are helpful for quick
operation.
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (i) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction

Digital Photo Professional (hereinafter, “DPP”) is high-performance RAW
image processing, viewing and editing software for EOS DIGITAL
cameras. It is often thought that RAW images are difficult to handle
compared with ordinary JPEG images, but using DPP, you can perform
advanced edits and print RAW images with ease.

RAW Images and Their Features
What is a RAW Image?

A RAW image is image data that has recorded output data of imaging
sensor. Because image processing does not occur inside the camera
when a photo is taken and the photo has been recorded in the special
form of “RAW image data + Image processing conditions information at
the time of shooting”, special software is needed to view or edit the
image.

* “RAW” means “in a natural condition” or “not processed or refined”.

What is RAW Development?

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. And
as for the RAW image, too, you cannot view it as an image on your
computer unless you perform subsequent image signal processing.
Therefore, even though it is digital, this processing is called
“development” and with EOS DIGITAL is performed using DPP.

With DPP, you can view, edit and print RAW images without having to be
particularly conscious of the development processing.

What Advantages Does a RAW Image Have?

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open an image in DPP, the image is instantly developed and you can
view the image as an image to which image processing conditions at the
time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Consequently, image
deterioration is not a problem and it is the perfect image data for users
who want to get creative with their images after they have been shot.

In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe”.

RAW image data

Image processing conditions information
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Main Features of DPP System Requirements

Following are the main tasks you can perform with images you have

downloaded to your computer. o Mac OS X 10.3 t0 10.4

] ) ) Computer | Macintosh with one of the above OS installed

View and organize RAW images cPU Minimum 400MHz, PowerPC G3, G4, G5 or Intel Contents at

. . . rocessor
Real-time adjustment of a RAW image P
. . . . o LT RAM Minimum 512MB
Various image adjustments while maintaining the original image _ Basic
Freely apply a Picture Style Display Resolution : 1024 x 768 or more Operation
View your image before and after adjustment in the same window Colors : Thousands or more
. . . . This software program is not compatible with UFS (UNIX File System
Trim an image and change its size o e o ogram! patible with UFS (UNIX Flle System) [ avanced
. . . Operation
: . DPP also runs comfortably on Intel-based Macintosh since it is a

Correction of lens aberration Universal application.

. : Advanced

Automatic/manual dust erasure processing S d| Image Cditing

. UppOrte mag eS and Printing

Convert from a RAW image to a JPEG or . .. —

. This software supports the following image types.

TIFF image and save _ Processing
Process large numbers of RAW images in batches Image type/Camera used Extension Lag%?nl:lgmggrs
Transfer the image to image editing software EOS-1Ds Mark 11l EOS-1D Mark IlI g

Pri RAW i EOS-1D Mark N EOS-1Ds Mark |l J

- Editin
rint a Image EOS-1D Mark I EOS 5D .
_ _ _ EOS 40D EOS 30D el
View and organize JPEG and TIFF images EOS 20D/20Da .CR2
. . EOS DIGITAL REBEL XSi/450D

Real-time adjustment of JPEG and TIFF RAW images | EOS DIGITAL REBEL XTi/400D DIGITAL Reference

imag es EOS DIGITAL REBEL XT/350D DIGITAL
Various image adjustments while maintaining the original image EOS D6000 EOS D2000

_ _ EOS-1Ds EOS-1D TIF
Print JPEG and TIFF images EOS 10D Index
G ey EOS DIGITAL REBEL/300D DIGITAL .CRW  —

Color management compatibility EOS DGO EOS D30
CMYK simulation for commercial printing : - ,

JPEG images ili;(;‘gZéSZ or 2.21-compatible JPEG PG, JPEG @ @

TIFF images | Exif-compatible TIFF images TIF, .TIFF

* Images converted to RAW images that have the “.CR2” extension in
CR2 Converter. For information on CR2 Converter, refer to Canon’s
web site.
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- Introduction

Downloading Images to Your Computer Erase dust shot with the image - p.61, p.63
Download images by connecting your cameraand ~ _, 07 Erase unwanted parts of an image - p.65 Contents at
computer Reduce image noise - p.56 a Glance
Download images using a card reader -p.9 Correct lens aberration - p.57
Use a Picture Style file = p.53 Basic
Viewing and Checking RAW Images Edit efficiently +pal Operation
Quickly enlarge parts of an image = p.l1l Edit an image while comparing the image before and _, 0.49
Sort images (check marks) - p.17,p.18 after adjustment ' Advanced
_Display an image _shot simultar_1eou5_|y as a RAW - p.20 Synchronize multiple images = p.50 Operation
image and JPEG image as a single image Display an area beyond the set range as awarning ~ _, 051
Display the images in the thumbnail list display at high -p21 indicator (Highlight/Shadow warning) ' Advang_e_d
resolution Restore an adjusted image to its condition at the time _, 0.39 Ir;naggﬁnéit;]ngg
Check shooting information such as the shooting date =» p.10, p.21 of shooting '
Processing
Editing RAW Images (Adjusting) Printing Laggelrl::r;gsers
Adjust brightness{darkness =>p.12, p.24 Print well on a Canon printer = p.39, p.68, p.69
grsmgr?;etcﬂj tlgcic?gggsértg?em y ng \',:Vfl'g:‘:)"r?’n:ﬁ]‘g"duce the color of the subject ) 39 1 68, .69 jSditing _
agii?ggt)the modulation and contrast of colors => p.27 @ Print with the shooting information = p.66 Images
Make skin tone look healthier (color tone) ->p.27 W Print a .thumbnail list of images _ = p67
Make the image colors more vivid (color saturation) ~ =» p.27 Qﬁr?tri?])élrrr;astjlttst]e color seen on screen with your ->p.74 Reference
Make an image sharp (sharpness) = p.29
'(A\V\(;Igltljtset gglér:(?eg)e to make color tone more natural - p.25 Conversion of Images e
Change an image to black-and-white or sepia tones Co.n\./ert a RAW image to a JPEG image 2p38p80
(monochrome) Edit in Photoshop = p.65, p.81
Trim parts of an image (trimming) =*p.35 Perform batch processing - p.80 @ @
Specify an aspect ratio that matches the size of the - .35 Edit (adjust) a JPEG image ->p.84

paper on which an image is to be printed
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1 Basic Operation

The basic operational flow — from how to download to your computer
images shot with a camera to checking, editing, saving and printing a
downloaded RAW image — is explained here.
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Starting up DPP

Click the Dock icon.

Digital Photo Profe ssio_nal

Click

DPP starts up and the main window ([Folder] window) appeatrs.

v

Main Window Display

In the main window, you can use tabs to select either the [Folder]
window or the [Collection] window. The [Folder] window displays the
images in folders on your computer, while the [Collection] window (p.33)
displays images selected randomly by the user from one or more folders
and gathered together.

Unless noted otherwise, the [Folder] window will be described as the
main window from this point on.

)
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Downloading an Image to Your Computer

Connect the camera and computer with the cable provided and
download the images saved on the memory card inside the camera.
For downloading images, start up the camera software “EOS Utility”
from DPP and use.

Select the save destination for the images.
Select the save destination in the folder area on the left of the
main window.
When creating a folder, refer to p.45.

800 Digital Photo Profe

1113,
1113

Folder Collection(0)
v = MacOsX
P A& Applications
[Z Temporary ltems
¥ [ B Users
v @ canon
» [@F Desktop
p % Documents
» (& Library
|# Movies
L& Music

» [ shared

Start up EOS Utility.
Select the [Tools] menu » [Start EOS Utility].

Tools
Start EQS Utility B

lder. alith

EOS Utility starts up.
EOS Utility
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ts to download images

Lets you select and download images

Camera settings /Remote shooting

“ Monitor Folder
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Connect your camera and computer and turn the
camera on.
Connect the camera and your computer with the interface cable
provided with the camera and turn the camera on.
For detailed instructions on connecting your camera and
computer, refer to the “EOS Utility Instruction Manual” (PDF
electronic manual).

Accessories

Starts to download images

Lets you select and download images

Camera settings/Remote shooting

Monitor Folder

Downloading of images begins.

The downloaded images are saved in the folder selected in step
1 and are displayed in the main window of DPP.

The downloaded images are sorted by date into folders and
saved.

-Z\@/i- Advantages of using EOS Utility to download images

Using EOS Utility to download images makes it easier to organize your
images as they are downloaded, sorted and saved into folders by date.

ﬁl You cannot start up EOS Utility in the [Collection] window
(p.6, p.33).
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Introduction

Downloading Images Using Your Card Reader Display the images downloaded to your computer.
In the [DCIM] folder copied to your desktop, select the folder

where the shot images are saved. Contents at
Digital Photo Professional a Glance

You can also download images to the computer using a third-party card
reader.

Load the memory card into the card reader.

M ic
7\ 8 Apptcatons Operfdtion
|- Temporary ltems
Y T;TS:km
”’ Advanced
L 12( IMG_0001.CRZ Operat'on
2 !m& Advanced
: . . L Image Editin
=» Images in the folder are displayed in the main window of DPP. am?primingg
Open aremovable disk icon in the folder area and
move the [DCIM] folder inside to a suitable place Processing
such as to the [Desktop]. R
806 Digital Photo Prof
= Editing
JPEG/TIFF
— Ma::l;:{er Collection(0) Images
"o Ei’ﬂ.‘fifl?;’
¥ v & caron
08 oo Reference
’Sb =)= Checking before downloading images
P [ Shared Index
T E— By selecting the memory card folder directly in DPP, the images in the
folder are displayed in DPP and you can check the shot images. -
The [DCIM] folder is downloaded to your computer.
All images are saved in folder units inside the [DCIM] folder. |§| Copying to your computer may take time when there is a large @ @
number of shot images saved in the memory card.
For details on the [DCIM] folder structure and the file names of @y
shot images, refer to “Folder Structure and File Names in the o

Memory Card” in the “EOS Utility Instruction Manual” (PDF
electronic manual).



Viewing an Image
Images downloaded to your computer are displayed as a thumbnails list Ch ang i ng the Size of Thumbnail Images

n the main W|_ndow. You_ can double-cllcl_< an image to open the edit You can change the size of the thumbnail images displayed in the main
window and display the image at large size.

Introduction

window and display them with shooting information attached. Contents at
a Glance
View Images as Thumbnails in the Main Window Select the [View] menu » desired item.
%
Rotate selected image Edit in Edit image window ®o Oper@tion
Main window ‘ View collections THG
= v Tab
v Folders
 Toolbar Advanced
Tool palette ®T Operation
Large thumhbnail i
v Medium thumbnail 2
Small thumbnail 33 Advanced
Thumbnail with information ¥4 Ir;na(jggﬁgtlitll,]ngg
Sort »
» The display changes to the selected item. 1 aprgzcﬁjrﬂggr s
of Images
Editing
JPEG/TIFF
Images
Click to select the image
Display thumbnails of all the images inside the Reference
folder selected in the folder area on the left
Index
|§| When aspect ratio information is attached to the shot image with @
the EOS-1Ds Mark Il or EOS-1D Mark I, the image is displayed —

as a trimmed image (p.35, p.92).

For a list of main window functions, refer to p.103. 10



Enlarge and View an Image in the Edit Window

Double-click
The edit window appears.
Edit window Tool palette
_ Digital Phato Prafessional - [ MacQSX [Users/canon/ Pictures Photo) xxxe_xx_xx/IMG_0001.CR2 |

RO T LRI
[ aa | MR

Pl 200

zials)

[ 1374, 573 ): 244, 245, 244

High quakty AW | Adobe RCE CMYE

It may take time for the image to redraw itself.

Click the [@®] in the upper left of the window to close the edit
window.

@ For a list of edit window functions, refer to p.106.

Enlarging and Viewing a Specific Area
Double-click the area you want to enlarge.

B ) Digial Phote Professional - | MacOSX [Users.canon  Pectunes Photo/xoo_xx_xx /WG 0001 CRZ |

e — —— Double-click

The area you double-clicked is enlarged to 100% (actual pixel
size). If you wait for a while, it changes to a clearer display.

® Double-click again to revert to the full view.

® To change the display position, drag on the image or drag the
enlargement display position of the tool palette.

Tool palette enlargement display position

Change the enlargement
display position by
dragging

== To display an image in an enlargement ratio other than 100%

Select the [View] menu » [200% view] or [50% view].

|§| You can change the enlargement ratio when you double-click (p.72).

)
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Adjusting an Image

You can perform a variety of image adjustments, such as adjusting the
brightness or changing the Picture Style of an image using the tool
palette of the edit window. You can easily restore an image to its original

settings with the [ ]] button even if you have made the wrong
adjustment. Try out the various adjustments.

As an example, the procedure to adjust the brightness of an image is
explained here.

Tool palette

| RAW RGE  NRiens ——

| Brightness adjustment

@ 0.00

| White balance adjustment

[3 Reverts the image to
the original settings

Drag the slider left or
right

=
/]

Shot settings | #] (
Picture Style | = |

Standard f #] { Browse.. )

5 ~

h—-ll}.ﬂ -80 -6.0 -40 =20 O 20 4.0

{Cuc;ntrasl: R v R
| Linear

{c{;lurmne: s v s

Enllnr saturation: R S

{S]I:l]arpneSS: ":'@I S o

The image brightness changes in real time according to the
amount of adjustments.

"2 The tool palette does not display

Select the [View] menu » [Tool palette].

About the Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens] tab sheets according to your editing
requirements.

Because adjustment made with the tool palette (it undergoes automatic
development processing each time) only changes the image processing
conditions, the “original image data itself” remains unaffected.
Therefore, there are no problems with image deterioration that arise with
editing and you can readjust your images any number of times.

See Chapter 2 onwards for more detailed information on the various
functions of the tool palette.

About Recipes

In DPP, all the adjustment contents (image processing conditions
information) made with the tool palette is saved to an image as data
called a “Recipe” (p.77).

ﬁl For a list of tool palette functions, refer to p.107.
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Saving an Image

If you perform the save operation described here, you can save all the
adjustment contents (recipe) made with the tool palette to the RAW
image.

Select the [File] menu » [Save].

Close window W
[ Save b5
Save As... ir 35
Convert and save... #D
Page setup... {1 3EP
Print... P
Print with detailed setting... 13D
Contact Sheet Prints... ~ 3P
Plug-in printing >
Info... |

Your adjustment contents (recipe) are saved to the image.

Saving

With DPP, you can perform the following types of saving according to
your requirements. For detailed information on each saving method,
refer to Chapter 2 onwards.

Save (p.37)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save.

Save as (p.37)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save as a separate RAW image. The original RAW image
remains unaffected.

Add thumbnail to image and save* (p.21)

Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images
redraw themselves more quickly.

© Convert and save (p.38)

Convert adjusted RAW image to a JPEG or TIFF image and save.
The original RAW image remains unaffected.

Batch process* (p.80)

Convert in batches adjusted multiple RAW images to JPEG or TIFF
images and save.

The original RAW images remain unaffected.

You can save * in the main window.
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Printing an Image

You can print images with a printer. As an example, the procedure to

print one image on one sheet of paper is described here.

Select the [File] menu » [Print].

Quitting DPP

In the main window, select the [Digital Photo
Professional] menu » [Quit Digital Photo
Professional].

Digital Photo Professional

Introduction

Contents at
a Glance

; About Digital Photo Professional
Close window JEW X
Preferences 36 -
cave ®S i Oper@tion
Save As... i+ #8S Services 2
Convert and save... ¥D ) —- ,
Hide Digital Photo Professional 36H Advanced
Palae sewup... ir3EP TP e < 3H Operation
Print... 3P
Print with detailed setting... <{r3D All
Contact Sheet Prints... ~3EP Advanced
Plug-in printing > L Quit Digital Photo Professional BEQ) Image Editing
and Printing
Info... %I =» DPP quits.
Processing

The [Print] dialog box appears. Large Numbers
] of Images
Print.

Specify the optimum settings for photograph printing in the

. . . . . : Editi
printer’s print settings dialog box and click the [Print] button. JpEé/'-?ﬁ:F
Printing begins. Images

N . Reference

@ To change the paper size

To set the paper size etc., select the [File] menu » [Page setup].

Index
Printing R

With DPP, you can perform the following types of printing according to

your requirements. For detailed information on each printing method, @ @

refer to Chapter 2 onwards.

Print one image (p.44)
Print using a Canon inkjet printer (p.39, p.42) ? Quitting DPP without saving adjustments to images
Print with a high-end C int .68 . . . : .
rint with a igh-end ~.anon printer (p-68) A confirmation dialog box for saving the images appears. Select [Yes to
Print with shooting information (p.66) all] to save the adjustment contents (recipe) to all the images adjusted
Printing a thumbnail list (contact sheet printing) (p.67) ) P g ) ' 14



D Advanced Operation

A more advanced operation — from efficiently checking images, to
various ways of editing an image, printing a RAW image using a Canon
printer and sorting images — is explained here.

Efficiently Checking/Sorting Images.................ccoc... 16
SOorting IMAQES......covvviiiei et 17
Sorting Images in the Main Window ...................... 18
Arranging Images in the Main Window...................... 18
Arranging bY TYPE ...oevvvieiiiiiiiiiiiiiiiiiiiiiiae 18
Arranging Freely ..........vvvveviviiiiiiiiiiiiiians 19
Displaying a RAW Image and JPEG Image as a Single
4= Vo [ 20
Improving the Quality of an Image in the Main Window ... 21
Checking Image Information.............cccevvvvvviiiiineeee e 21
Editing an Image ........ccoooovveviiie vt e 23
About the RAW Tool Palette..........ccccvevviveeeeeiiiineee, 23
Editing with the Tool Palette in the Main Window.. 23
Adjusting Brightness .........coiviiiiiiiiiiiiii i 24
Changing a Picture Style ...........cccccvviiiie, 24
Picture Style File ... 25
Adjusting Color Tone by Changing White Balance.... 25
Adjusting Color Tone Using Click White Balance...... 26
Adjusting Contrast .............ceevvvevvviririiiiiiiii.. 27
Changing Color Tone and Color Saturation............... 27
Adjusting MoONOChrome ..............eeevvvvvivviiiiiniiiiiennns 28
Adjusting Sharpness..........ccccciiiiiiiiiiieee, 29
Automatically Adjusting Brightness and Color (Tone
CUIVE ASSISL) e 30

Editing Efficiently ... 31
Editing in the Edit Image Window...............cccccevvveenen. 31
Changing the Thumbnail Display Position to a Horizontal
POSIION....uiiiie e 33
Gathering and Editing Images in the Collection Window ... 33

Trimming an IMage.......ccoooevvveiiiiiieeeeece e 35

Applying Adjustment Contents to Other Images...... 37

Saving Editing Results............ccccceiv v, 37
Saving Editing Contents to a RAW Image.................. 37
Saving as a JPEG or TIFF Image............cccccvvvvvnnnnn. 38

Re-Editing an Image.........ccccceevvieeeeiieiiiieeiiciee 39

Printing @an IMage ......cccooovvviiii e 39
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint EX ............cccvvvvnne. 39
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint...............ccccvvvveeeeee. 42
Printing Photographs with a Printer other than the Canon
INKJEt PriNterS......cooiiiiiiii e 44

Organizing IMages .......ccuveiiiieeeeiiiii e 45
Deleting an Unwanted Image ............ccoevvvvvviiieeeeeeennnns 45
Creating a Folder for Saving Images...............ccceeee. 45
MOVING IMAGES ....ccevviiiiiieiie et 46
Moving Images in Folders .........ccvviviiiiiiiiiiiieeeceeeans 46
Registering Frequent-Use Folders (Bookmark
ReQISLration) ......ccooeeeeieeeee e 47

Organizing Bookmarks ..........ccccevviiiiiieeeeeeiiii 47
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window
and efficiently check each image. You can attach check marks and sort
images into three groups.

Display the quick check window.
Select the [Tools] menu » [Start Quick check tool].

Tools

Start EOS Utility M 3EE
Transfer to Photoshop 3P

Start Quick check tool “C3¥F ]
Start Trimming too T
Start stamp too NaES

Start Rename tool 3R

Sync folder with EOS Utility

The quick check window appears.

Click the [Next] or [Previous] button to switch
between images to be checked.
Quick check window

w2715 IMC_D002.CR2 (3456 x 2304]

All the images displayed in the main window can be checked in
the quick check window.

Double-click the area you want to enlarge.

e 50 click

—_

The area you double-clicked is enlarged to 50% view.

Double-click again to revert to the full view.
© To change the display position, drag on the image.
@ To quit, click the [OK] button.

)
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AL/

> Convenient functions of the quick check window

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switch between images using the keyboard

You can also switch between images by pressing the <38> + <—> or
<H> + <> keys.

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

|§| The enlargement ratio when an image is enlarged is half (50%) of
the 100% (actual pixel size).

You can change the enlargement ratio to 100%, when an image is
enlarged (p.72).

For a list of quick check window functions, refer to p.109.

Sorting Images

You can sort images by attaching three types of check marks for each
subject or theme.

Attach check marks for sorting.
Check mark

2715 IMC_0002.CR2 (3456 x 2304]

=» The selected check mark appears in the upper left of the window.

@ Click the [Clear] button to remove the check marks.

)
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Sorting Images in the Main Window

You can sort images by attaching three types of check marks in the main
window.

In the main window, select the images you want to
sort and attach a check mark for sorting.

bs/Photo/xxxx_xx_xx ]

Check mark

The selected check mark appears in the upper left of the image
frame.
Click the [Clear check] button to remove the check marks.

Vs

5@3 To select multiple images in the main window

Click on desired images while holding down the <g8> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <shift> key.

Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging by Type

Select the [View] menu » [Sort] » desired item.

Edit in Edit image window -
View collections NHG
v Tab
v Folders
v Toolbar
Tool palette #ET
Large thumbnail E
¥ Medium thumbnail 32
Small thumbnail 3*3
Thumbnail with information 384

0 + File name
RAW priority

Check mark1
Check mark2
Check mark3

Shooting Date/Time

The images are arranged in the order according to the selected
item.
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Sort item

Check mark1 -
Check mark3
Shooting Date/Time

File name

RAW priority

Description

Images with check marks take priority and are
sorted in number order.

Images are sorted by shooting date and time
from the earliest.

Images are sorted by file name in alphanumeric
order (Oto 9 » Ato 2).

Images are sorted in the following order: RAW
images - JPEG images - TIFF images.

-Z\@E Check mark order

When you assign check marks 1 to 3, the images are sorted as follows:

1 selected: 123
2 selected: 2—1->3
3 selected: 3-2~>1

Arranging Freely

Drag and drop the image to the desired location.

[ Dighal Phots Professional T [dn Wiew Beckmark Adjiment  Tooh Windew Fei T waiiie @
Lilalsl - [ Mt | 1

The image moves to the desired location.

® You can also select multiple images (p.18) and move them.

©® The order of rearranged images is maintained until you quit DPP
or select another folder in the folder area.

@ Select the [View] menu » [Sort] » [File name] to revert to the
order before the images were rearranged.

b o i 11 Pt of seected magen: |

A/

5@3 Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you quit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View settings] tab sheet in Preferences to maintain
the order of images without changing the image file names (p.72).
Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.82).
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Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Digital Photo Professional] menu »
[Preferences].

Select the [View settings] tab sheet and checkmark
[Display only CR2 images for CR2 and JPEG files of
the same name].

-

Preferences

+ General settings l View settings lTaoI palette Color management -
——

Grid pitch
T B4 Pixels(8-256)

Locking selected image
@ Images opened in Edit window remain selected in main window

Magnification in Edit window

%) Fit to window ) 50% ) 100% ) 200%

Magnification when the Edit/Edit image window is double-clicked

-
O s0% ® 100% ) 200% |
' # Display only CR2 images for CR2 and JPEG files of the same name )

Sort order in main window
| Retain sort order
Highlight/shadow warning
Highlight C 192 nez-2ss
Shadow 0 (0-64) ]
Quick check tool display

@ so% ) 100% (mairé reduction off)

Cancel \ f OK 3

The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [ZXD] mark (p.105).

? RAW images with the extension “.CR2” can be displayed as a
single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2” and JPEG
images simultaneously. Images that have been simultaneously shot with
a camera that shoots RAW images with the extension “.CRW” or “.TIF”
cannot be displayed as a single image.

-I\@/i— When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.
 Deleting an image (p.45)

* Moving or copying an image (p.46)

» Checkmarks (p.17, p.18)

» Rotating an image (p.103, p.109, p.110)

* Attaching a thumbnail to an image and saving (p.21)

® Images added to the [Collection] window
When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[3B] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2 (p.104).

@ In step 2, if you uncheck [Display only CR2 images for CR2 and
JPEG files of the same name], the RAW image and JPEG image
are displayed as separate images.
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Improving the Quality of an Image in the Main Window
Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images redraw
themselves more quickly.

With all the images selected, select the [File] menu »
[Add thumbnail to image and save].

Open in Edit window... #0
Open in Edit window (enlarged)...

Close all

Open window 3EN
Close window HEW
Save #S5
Save As {1385

( Add thumbnail to image and save {r3T ]

Convert and save... #£D
Batch process... ¥B
Create new folder... 138N
Page setup... {+3#EP
Print... #P
Print with detailed setting... + D
Contact Sheet Prints... ~HP
Plug-in printing >
Add to collection ®G
Remove from collection {3 G

AL

5@3 The extent of the improvement in quality

The quality is improved for any RAW, JPEG or TIFF image. While the
image quality improves regardless of the thumbnail size (p.10), selecting
[Large thumbnail], with its larger display size, shows the improvement
more clearly than [Medium thumbnail] and [Small thumbnail].

|§| A large number of images may take some time to add.
You can specify a presetting for JPEG images to improve the
quality of all main window thumbnails (p.70, p.71).

Checking Image Information

Select the image for which you want to check the
Image information.

Select the [File] menu » [Info].

Open in Edit window... #O
Open in Edit window (enlarged)...
Close all
Open window 3N
Close window W
Save 35
Save As... 1385
Add thumbnail to image and save 3T
Convert and save... ®D
Batch process... 3B
Create new folder... 3N
Page setup... {r3EP
Print... P
Print with detailed setting... 4D
Contact Sheet Prints... ~¥P
Plug-in printing >
Add to collection HG
Remove from collection {+#G
Delete

| info... %l )

The image information window appears (p.22).
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Select a tab sheet and check information.

[Shooting Information] tab sheet

[Metadata] tab sheet

& & & |# IMG_0001.CR2 & & 8 ¥ IMG_0001.CR2
—E Shooting Information | Metadata Shooting Information | Metad }
File name m
IMG_0001.CR2 | Description )
Camera Model Name 1
Canon EOS oo | .
" | [Document Title]
Firmware }
o ]
Shot date | [Author]
000 000K 300230010 | OO0
Tv (Shutter Speed) | [Author Title]
| XXANKHAX
1/400 Sec. | [Description]
Av (Aperture Value) 1 OO
F13 : [Description Writer]
: XXANKHAX
Metering Modes : [Keywords]
3 ) | 00000
Exposure Compensation |
213 I .
[Copyright Status]
150 Szp;;d : Public domain
L | [Copyright Motice]
ens ) XXANKHAXK
% [Copyright info URL]
Focal length |
17.0mm | I
Image size |
3456 x 2304 |
Image Quality 1
1
Flash !
o i
White Balance
AF mode
Picture Style
Parameters
Tone curve
Sharpness level
Pattern Sharpness -
Contrast -
Sharpness ‘
Color saturation
Color tone
Highlight tone priority - .
A £

Shooting information is displayed in the [Shooting Information]
tab sheet, while IPTC* information appended to the image in
Photoshop CS3 after shooting is displayed in the [Metadata] tab
sheet. IPTC* information provides additional comments on
images, such as captions, credits and the shooting location. The
information is sorted into 5 different categories and can be
viewed by selecting [Description], [IPTC Contact], [IPTC Image],
[IPTC Content] or [IPTC Status] from the list box in the

[Metadata] tab sheet.

* International Press Telecommunications Council (IPTC)

A/

> Convenient uses in the main window

A/

Difference with the [Thumbnail with information]

Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in
[Thumbnail with information] (p.10).
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Editing an Image

This section explains how to adjust an image using the tool palette in the
edit window.

You can easily restore an image to its original condition with the [[ 5]
button even if you have made the wrong adjustment. Try out the various
adjustments.

How to make adjustments using the [RAW] tool palette functions, and
how to adjust automatically with the [RGB] tool palette are explained in
this section.

Edit window Tool palette
BN A Digital Photo Professional - [ MacOSX fUsers feanon /Pictures Photo) oo xx(IMG_0001.CR2 | s - -*-::-tv‘m
4
Tt setinge .
i s
Standurd Ir' Browie

AW [ Adobe RCE CWVE_ 7 |

(1374, 5T3): 248, 345, 244 High quakty

The image changes in real time according to adjustments
performed with the tool palette.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <38> +
<Z> keys.

|§| You can rotate an image in the [Adjustment] menu.
You can adjust an image while comparing the image before and
after adjustment (p.49).
You can synchronize multiple images and edit while comparing
them (p.50).

Refer to p.106 for a list of edit window functions, and p.107 for a
list of tool palette functions.

About the RAW Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens] tab sheets according to your editing
requirements.

Adjustments similar to those that can be performed with the functions of
your camera can be performed using the functions of the [RAW] tool
palette. When the camera settings were incorrect during shooting, or
when the shooting result is not what you visualized, you can get closer
to what you envisaged with the [RAW] tool palette which is similar to the
camera.

All functions other than [RGB] tool palette automatic adjustment, and
each function of the [NR/Lens] tool palette are explained in Chapter 3.

Editing with the Tool Palette in the Main Window

By clicking the [Tools] button (p.103) in the toolbar on the main window,
the same tool palette that appears in the edit window is displayed and
you can edit images.
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Adjusting Brightness

Brightness of an image can be adjusted. Move the slider to the right to
make an image brighter and to the left to make an image darker.

e L RGE  NRiLens
|Eﬂ'ghmess adjustment [u - |
L fx
|||||||||IF\2|||||||||| I"}I:”:I
|Wh;'la balance adjustment =] I|
1 | 2 | 3 | Register..
Shot settings | :] P Tuna:Y

Reverts the image to

||—the original settings

— Enter a numerical
value

Drag the slider left or right

|§| The adjustment range is —2.0 to +2.0 (in 0.01-stop increments when

entering a value).

Changing a Picture Style

If the image you shot is different to what you visualized, you can change
the Picture Style to get closer to what you envisaged.

Even if you have saved the image (p.37) with [Monochrome] (p.28)
selected, you can still change to another Picture Style at any point by
simply selecting a Picture Style other than [Monochrome].

‘ Picture Style

ﬂﬁ‘i Reverts the image to

[ Standard

|:]]|," Browse... |

the original settings

Select

A

“

i8]

TN
el A

i k iy = 4
0 =80 . -6.0 -4.0 =& 0 2.0 4.0
Contrast: e
{U‘:]ln rm 1 1 1 1 (;? 1 1 1 I

[ -] Linear

Color tone: =

{n} 1 1 1 1 v 1 1 1 1
Color saturation:

{u] ] 1 1 1 (? 1 1 1 I
h H

s arpness .I_e ] 1 1 1 I ] 1 1 1

Even if the RAW image is from a camera that does not have

Picture Style settings, you can still set a Picture Style as long as
the RAW image is compatible with DPP (p.3).
You can retain the [Color tone], [Color saturation], [Contrast] and

[Sharpness] settings, even if you change the Picture Style (p.73).
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Picture Style Description

Standard The image looks vivid.

Ordinarily, this setting is suitable for most images.

For nice skin tones.

Effective for close-ups of women and children. By
changing the [Color tone], you can adjust the skin
tone (p.27).

Portrait

For vivid blues and greens.
Effective for making images of landscapes
impressive.

Landscape

For natural colors and subdued images.
Effective for base images which are to undergo
adjustment.

Neutral

When the subject is photographed under a color
temperature of 5200K, the color is adjusted
colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment.

Faithful

For black and white images.
You can also adjust with [Filter effect] or [Toning
effect] (p.28).

Monochrome

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

(Picture Style file
registered in the
camera)

[Picture Style file
applied in DPP]

The name of the Picture Style file applied in DPP
is displayed in [ ].

Picture Style File

A Picture Style file is an extended function of Picture Style. It is a file that
offers effective image characteristics for an image shot in an extremely
limited scene. Refer to p.53 for how to use Picture Style files.

Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source at the time of shooting an
image of, for example, pale-colored flowers.

.................... [ RAW RGE NRALeNs b
|Erighrn£ss adjustment = .|
:I:I!!::|I||!?:|:II|:;|II l:}DD
|White balance adjustment t - JJ— Reverts the image to
(] P (%] 5 |( Regivter.. the original settings
I Shot settings = ll Tune..
Select

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (p.26).

@< Tune with color tone

To make further fine adjustments to color tone after adjusting the white
balance, you can use [Color tone] (p.27) to get closer to your
requirements.

® You cannot register the adjustment results as personal white
balance (p.79) when you have selected [Shot settings] from the list
box.

|§| Refer to your camera’s Instruction Manual for details on each white
balance setting.
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Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

———f RAW | RGBE  NRiens
|Erighmess adjustment = |
|||||||||||m||||||||||| G-DD
|White balance adjustment = |
P2 1] 2] 3 |€ register... ) )
g : Click
Shot settings | ::}[: Tune... :l

Click on a point that is to be the standard for white.

Galaral 77 W GOE.CRE —a

s nce s LU

el r— Q00

ann | Digital

| (=)
7 E
&T_QE‘._‘-
[ 5]

St ) (o] )

RAW [ Adsbe BER CMVE

12230, 1285 ) 149, 116, 123

‘ Click Reverts the
The coordinates of the cursor position and the  image to the
RGB values (8-bit conversion) original settings

The color of the image is adjusted with the point you selected as

the standard for white.
If you click on another point in the image, the white balance is

adjusted again.
To finish click white balance, click the [] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

|§| The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.

)
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Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast
weaker.

Q 5 .]l— Reverts the image to

| Picture Style
the original settings

|$]|," Browse...

% “d

Standard

rL-il].!.i] -8.0 6.0 -40 =20 0 20 4.0 .
—— Drag the slider left or

Contrast:

e T Sl right (9 steps)
 Linear

E;:].Iurturre: s 6’ A

E:::Inr saturation: R

{s{.larpness: ‘T@I R e

Display the value of the setting

-I\@/E [Linear] - A function for advanced adjustment

Use [Linear] when you will be adjusting separately using image editing
software that has advanced editing functions. Note that when [Linear] is
checkmarked, the image will become dim.

Changing Color Tone and Color Saturation

Skin tone and overall color saturation can be adjusted.
If Picture Style (p.24) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (p.28).

Reverts the image to

‘Picture Style hi;
the original settings

Standard f :] { Browse.. )

[ d

| A :
1 R
N Lol r Ty | :
o .
100 -30 -60_-40 -20 0 20 40

Contrast: -——-—e————————-»
(U} 1 1 1 1 1 I 1 1

| Lingar .
ol o, Drag the sliders left or
() i i 1 |l ,I 1 1 1 rlght
Caolor saturation: f Y
(017 I 1 1 |t (:? ’I 1 1 1
Sh b
{]_]arpness T@ | 1 I e I Rl B |
Display the values of the settings
Color tone: Mainly used for adjusting skin tones. Move the

slider to the right to make skin tones more
yellow, and to the left to make skin tones
redder.

Color saturation: The overall color depth of the image is
adjusted with color saturation. Move the slider
to the right to make the color deeper, and to
the left to make the color weaker.

ﬁl The adjustment range is —4 to +4 (in 1-stop increments).
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Adjusting Monochrome

When the Picture Style (p.24) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering and with the
look of a single-color photograph.

Select [Monochrome] in the [Picture Style] list box
(p.24).

[ [=] Reverts the image to
the original settings

Monochrome i#]f' Browse... \l

o 4

rh—-llf!.lfl =30 ~6.00 4.0 =20 0 20 4.0

Contrast: =
{0 (ROEe T Tt V TR

| Linear .
Filter effect: (5'5‘ prag the sliders left or
(None) ) ! : ! rlght
Toning effect: 3

{Mone)

2
Sharpness: 6

]

Display the values of the settings

Filter effect: Creates an image where the white of clouds and the
green of trees are emphasized in the same
monochrome photograph.

Filter Example of effect
None Ordinary monochrome image without filter effect.
Blue sky is reproduced more naturally and white
Yellow
clouds emerge clearly.
Oranae Blue sky becomes somewhat darker. The
9 brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red :
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

© Toning effect: You can create a single-color monochrome
photograph to which color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

:@5 Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] (p.27) slider closer to
the right.
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Adjusting Sharpness

You can make the overall atmosphere of an image harder or softer.
Move the slider to the right to make an image harder and to the left to

make an image softer.

| Picture Style

[[EJII— Reverts the image to

Standard

|¢]( Browse... :I

"

4

100 B0 -60 -40 -Z0

Caontrast:
{U] I 1

[ Lingar

Calor tone:
{0] 1 1

Calor saturation:

{0 1 1

Sharpness:

{:!_] @IIIIIIII

Display the value of the setting

the original settings

!
Drag the slider left or right

? Sharpness is unnatural

Adjust sharpness with the window view set to [100% view], [50% view]
or [200% view]. If the view is set to [Fit to window] (full view), the
sharpness may seem unnatural.

@ The adjustment range is 0 to 10 (in 1-stop increments).
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.117). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click on the [RGB] tab sheet and click the desired

automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most

images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.
——— raw || reB || NRiLens
\Tcm curve assist [0 | [+ | @5 H—— Reverts the tone curve
Tone curve adjustment =y to the original settings
e R [ c | s |
- : .
255 High
Standard
D p 1
o] 255
EﬁghTHESS: Y ey DE
cuntrasr- bty rrene D?
Hue trrrr et |3! DE
saturarlun AR R R IR AR R R |bi ll:”:l z
Sharpness: @—ibl 0 ?

The tone curve changes as adjusted.

~@< Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

¢ Images which have been shot with the proper exposure

» Images where the brightness is unbalanced

* Images which are too dark

¢ Images which have extreme backlighting

(D It you click the [(E2®]] button, the tone curve as well as the [Hue] and
[Saturation] revert to the default settings. Take care when adjusting
the [Hue] and [Saturation] individually (p.88).
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Editing Efficiently
Editing in the Edit Image Window

The thumbnail display and the edit window are combined and images can
be edited efficiently while quickly switching between images to be edited.
Images to be edited are selected beforehand in the main window.

In the main window, select the images you want to edit.

Switch to the edit image window.

Click

The main window switches to the edit image window.

Edit the image.
Change the size

Select the image to be edited
The selected image is displayed as an enlargement in the
middle of the window

=* It may take time for the image to redraw itself.
The same tool palette as in the edit window is displayed and you
can edit the image.
To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <3f> +
<Z> keys.

)

Introduction

Contents at
a Glance

Basic
Operation

Advaficed
Op ion

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00
©

31




Double-
click

A | i 08 CTE

[ E5RL T8 00 T 48 gt uinny

The area you double-clicked is enlarged to 100% (actual pixel
size). If you wait for a while, it changes to a clearer display.
Double-click again to revert to the full view ([Fit to window]).

To change the display position, drag on the image or drag the
enlargement display position (p.107) of the tool palette.

To return to the main window, click the [Main Window] button on
the toolbar.

A/
~

Q-

To display an image in an enlargement ratio other than 100%

Click the [50% view] or [200% view] on the toolbar.

5

You can change the way the tool palette is displayed (p.73).

You can change the enlargement ratio when you double-click
(p-72).

With the edit image window, you can only select images from one
folder. To gather images from several folders for editing, refer to
“Gathering and Editing Images in the Collection Window” (p.33).
For a list of edit image window functions, refer to p.110.

)

Introduction

Contents at
a Glance

Basic
Operation

Advaficed
Op ion

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00
©

32




Changing the Thumbnail Display Position to a Horizontal Position

Select the [View] menu » [Change thumbnail
position].

I Photo Professional File Edn  Wiew  Adjustment  Tools Window Help 41 Wed 11:17AM @
# Digital Photo Professional - [ MacOSX/Users /canon/ Pctures/ Photo/ xxxx_xx_xx, /IMGC_0000.CR2 |

AW { Adsbe BEB €MV

If you select [Change thumbnail position] again, the thumbnail
display reverts to the vertical position.

Gathering and Editing Images in the Collection Window

You can gather any randomly selected images together in the
[Collection] window for viewing, comparison and editing. You can gather
images from several folders as well as from only one folder, allowing
you to work with them efficiently.

Select images from the [Folder] window in the main

window, and select the [File] menu » [Add to collection].

Open in Edit window... #O
Open in Edit window (enlarged)...

Close all

Opemwindow 3N
Close window W
Save #S
Save As... 1+ 35S
Add thumbnail to image and save {r3T
Convert and save... ¥D
Batch process... 3B
Create new folder... {r3EN
Page setup... {r3EP
Print... P
Print with detailed setting... T4 ¥D
Contact Sheet Prints... ~HP
Plug-in printing >

( Add to collection HG ]

Remave from collection 3G

The selected images are added to the [Collection] window and the
number of selected images is shown on the [Collection] tab sheet.
When you add RAW and JPEG images displayed as a single
image (p.20), the number of images shown on the [Collection]
tab sheet increases by 2.

You can select several images and add them to the [Collection]
window.

You can also add images to the [Collection] window by selecting
images, clicking on the image while holding down the <control>
key, and selecting [Add to collection] from the menu that appears.
You can add up to 1,000 images to the [Collection] window.

)
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Select the [Collection] tab sheet.
000

11113,
L]

Folder Collection(14)
v = MacOsX
» & Applications 2
[ Temporary Items (o
¥ L& Users
v @ canon

The selected images are displayed in the [Collection] window.

Check displayed images in the [Collection] window.

@  Digital Phato Professional File Edit View Bookmark  Adjstrunt  Tooks Window Help m 4 Weda0ire @

Hiagh quabty Recipe data Yei Narrber of images 15 Nearnber of selected images | e

Edit the images.
You can now edit the images displayed in the [Collection]
window.

=Q= To remove images from the [Collection] window

Select the images to be removed in the [Collection] window and then
select [Remove from collection] in the [File] menu. (You can also remove
images from the [Collection] window by selecting the images, clicking on
the image while holding down the <control> key, and selecting [Remove
from collection] from the menu that appears.)

Note that even if you remove an image from the [Collection] window, the
original image remains unaffected.

® Images brought together in the [Collection] window are

retained until you quit DPP
When you quit DPP, the gathered images disappear from the
[Collection] window, but this removal from the [Collection] window
does not mean that the original images themselves have been
deleted.

® Modifications to the image are applied to the original image
Modifications made to images added to the [Collection] window
are all applied to the original image.

@ You cannot use the following functions in the [Collection] window.
e Starting of EOS Utility (p.7), or synchronizing of folders with EOS
Utility
» Batch change the file name of images (p.82)
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Trimming an Image

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical.

Also, when aspect ratio information is attached to an image shot with the
EOS-1Ds Mark Il or EOS-1D Mark lll, the trimming range based on the
aspect ratio information is displayed.

Select the image to be trimmed.

Open the trimming window.
Select the [Tools] menu » [Start Trimming tool].

Start EOS Utility 3B E
Transfer to Photoshop 3P

Start Quick check tool “C¥F
| Start Trimming tool T )
Start Stamp tool 3RS

The trimming window appears.

When the image has redrawn itself, select a ratio and
drag the trimming range.
Trimming window

Y # 1/1 MG 0001.CR2 [3456 x 2304]

Select a
S e trimming
"""" °  ratio

T Drag the
~ < trimming
range

NG S04 15 3026, 1ENO ) = (1969 x 132611 190

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

List of aspect ratios (width : height)

v Free
1:1
3
2:3
4:3
3:4
5:4
4:5
A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

[Free]: You can trim an image to any size, regardless of the
selectable ratio.
[Custom]: You can trim an image at the specified ratio.

A Click the [OK] button to return to the main window.
%" < The trimming range frame is displayed in the trimmed image
(p.105).
When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its trimmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at

any time

A trimmed image is displayed or printed as a trimmed image.

However, since the image is not actually trimmed, you can always

revert to the original image by clicking the [Reset] button in the

trimming window or performing the “Re-Editing an Image” procedure

(p.39).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.105).

 Edit window: The image is displayed in its trimmed condition.

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when converted and saved
The trimmed RAW image actually becomes a trimmed image when
converted to a JPEG or TIFF image and saved (p.38).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to an image shot with the
EOS-1Ds Mark Il or EOS-1D Mark I, the set trimming range based
on the aspect ratio information is displayed. However, since the image
is not actually trimmed, you can change the trimming range or revert
to the condition before trimming.

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.112).

~
-

A/

> Convenient functions of the trimming window

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming
window. With the trimmed image displayed, click the [Copy] button
and then click the [Apply All] button. This will apply the trimming range
to all the images selected when the trimming window is displayed.

|§| For a list of the trimming window functions, refer to p.112.
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Applying Adjustment Contents to Other Images

You can copy the image adjustment contents (recipe) adjusted with the
tool palette and apply it to other images.

You can efficiently adjust multiple images by adjusting one image and
applying the results of this to multiple images shot in similar shooting
environment.

Select the adjusted image and then select the [Edit]

menu » [Copy recipe to clipboard].
The recipe is copied.

Select the image to which the recipe is to be applied
and then select the [Edit] menu » [Paste recipe to
selected image].

The recipe is applied to the image.

|§| The recipe (p.77) can be saved as a separate file from the image
and loaded and applied to another image (p.78).

Saving Editing Results
Saving Editing Contents to a RAW Image

All the contents (recipe) adjusted with the tool palette as well as the
trimmed (p.35) range information can be saved to a RAW image or to a
separate RAW image.

The adjustments made with the tool palette (p.52 to p.57) and the dust
erase processing explained in Chapter 3 (p.61 to p.65) can also be
saved in a RAW image.

Select the [File] menu » desired item.

Open in Edit window... #O
Open in Edit window (enlarged)...

Closerall

Open window |
Close window W
Save 35

Save As... 135S

Add thumbnail to image and save (3T
Convert and save... HD
Batch process... 3B

Create new folder... 3N

Page setup... {r3EP

Print... 3P

Print with detailed setting... 4 ¥D
Contact Sheet Prints... ~HP

Plug-in printing >
Add to collection HG

Remove from collection {+#G

Delete <&
Info... £ |

Your adjustments are saved to the image.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00
©

37




Introduction

Saving as a JPEG or TIFF Image Specify the necessary settings, and then click the
To vi dit and print a RAW i ith soft ther than DPP. [Save] button.
0 view, edit and print a image with software other than : : , .
convert to a more versatile JPEG or TIFF image and save. By default, the image is converted and saved to a JPEG image SO el
with the highest image quality, without changing the image size. a Glance

The image is saved as a separate image, so the RAW image remains

Change the settings according to your requirements.

unaffected.
Convert and save
] Basic
Select the image to be converted. ((save as: (ope_o0 ) }—— Enter a file name Operation
( Where: [ [ Photo ':] '7— Se|eCt the save
: destination
Select the [File] menu » [Convert and save]. Lie format _ Advced
(Kind o file Exif-JPEG w:])—— Select an image type Op o
Image guality A s " a 10
Open in Edit window... FO Qutput settingll
Open in Edit window (enlarged)... Output resolution 350 dpi [ En;d ICC profile Advanced
Close all o
:'n-.-r e e Resize setting o . Image Editing
Upen winaow - " Resize j i
Close window HEW ENth— e i, and Printing
| 3504, x 2336 pi&:-l_:
{3504 pixel ) {2336 pixel )
Save ggs o L:t\:.;pe(l Fatio p i
Save As... {1385 = LPFOCSSSItI;]g
L1 (Cancel ) [ Save )} Click and save ag%elm:g]esers
Convert and save... #D
Batch process... #EB =» The RAW image is converted to a JPEG or TIFF image which is —
Create new folder... 08BN then saved as a new image in the specified save destination. JFI’ESCI;/I!IIPFF
Page setup... {r38P Images
Print... #EP
Print with dertailed setting... D
Contact Sheet Prints... ~3P Reference
Plug-in printing >
Add to collection #C
Remove from collection {+ 3G
Delete #¥E Index
Info... |

The [Convert and save] window appears.

dust-erased image explained in Chapter 3 (p.61 to p.65) actually

becomes a trimmed image or dust-erased image.

You can reduce the noise characteristic of JPEG images which @
occurs when you convert and save an image as a JPEG (p.70).

You can batch convert and save multiple images (p.80).

For a list of [Convert and save] window functions, refer to p.111.

ﬁl By saving as explained on this page, a trimmed image (p.35) or @ @
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.23), so the “original image data itself” remains
unaffected.

Also, the trimming range information of a trimmed image (p.35) is simply
saved to the image.

For this reason, you can undo any adjustments saved (p.37) to the
image, trimming information, and revert to the condition when last
saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu » desired item.

Rotate Left 3EL
Rotate Right 3R
Add check markl HF1
Add check mark2 HF2
Add check mark3 3EF3
Clear check mark 3 F4
Work color space >
Tone curve assist - Standard

Tone curve assist - High

Revert to last saved settings 3#Z
Revert to shot settings ~37

The image reverts to the conditions of the selected item.

Printing an Image

This section explains how to print high-resolution photographs easily
with the Canon inkjet printers compatible with the Canon printing
software, Easy-PhotoPrint EX or Easy-PhotoPrint. It also explains how
to print photographs using other printers.

Proceed to the page for the printer you are using.
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint EX (Same page)
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint (p.42)
Printing Photographs with a Printer other than the Canon Inkjet
Printers (p.44)

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint EX

You can perform the following types of photograph printing with the
Canon inkjet printers compatible with the Easy-PhotoPrint EX
(hereinafter, “EPP EX”) :
Simple printing of RAW images
Printing with faithful colors
® High gquality printing using the color reproduction range of Adobe RGB
and a Canon inkjet printer

To perform this printing, it is necessary to first install EPP EX version 1.1
or later on your computer.
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Select the image to be printed.

Start up EPP EX.

Select the [File] menu » [Plug-in printing] » [Print with Easy-

PhotoPrint EX].

e

Open in Edit window...

Open in Edit window (enlarged)...
Close all

Open window

Close window

Save

Save As...

Add thumbnail to image and save
Convert and save...

Batch process...

Create new folder...

Page setup...
Print...
Print with detailed setting...
Contact Sheet Prints...
Plug-in printing

Add to collection
Remove from collection

EPP EX starts up.

#0

#EN
#EW

£S5
{385
3T
F#D
F*B

{r3EN

i+ 3P

P
{+ 3D
~3P

#G

Print wnh Easy PhotoPrint EX

{+ 3G ‘

In the EPP EX window, select the [File] menu »

[Preferences].
Fie |

My Recent Files »

Next Step

Preferences...

The [Preferences] window appears.

In [Print Quality], select [Quality Prlorlty]

6 aNa) Preferences
Print Advanced
Number of copies : 1 : Copies
Printing Order ByDate |
Amount of extension of borderless printing “Default —]
Print Quality ( Qua!lty Pncnrm,I
¢ Optmn ]
-_: Defaults )
L -
( Help ) ( cancel ) ( oK )

Quality Prioriy___1#) J——————— Select

Quality
Priority

Click to close the window

Specify the number of sheets to be printed, and then

click [Select Paper].
EPP EX

CLE i P P iy PRraP B

‘Specly e number of copies 1 £rink e aach image.

Photo Pring

|@ selectPager | —
= 0004 BT

mmuiﬁga

ST
Exit

2
-

Exi Print

“’Gd“‘f—"— Click to

increase the
number of
sheets to be
printed

)
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Select the paper type, and then click the [Layout/

Print] button.

anA Mew Phota Print - Easy-PhatoPrint EX

‘Sabect e Drinier 13 s, Tien Select The SiTe AN De 0 Sager 10! DrNENG
Pheoto Pring

Casan 1K

Letrer
5

Exi Print

" |—— Select the

paper size

Help. |

Click

and type

Specify the layout, and then click the [Print] button.

—_— _
anA Biew Phata Print - Easy-FhotoPrint EX

Exif Print

Select the

Help. |

[ |

Click to print
Printing begins.

layout

? Additional information

Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

The printed image’s color is not what you expected

In the EPP EX window, select [Preferences] in the [File] menu and
then click the [Advanced] tab in the [Preferences] window to display
the [Advanced] tab sheet. In the [Advanced] tab sheet, select [Enable
ICC Profile] in [Color correction for printing] and print using the
[Perceptual] setting (p.118).

¥

-@> Advantages of printing using EPP EX

Printing with faithful colors

When the color space (p.118) is set to SRGB or Adobe RGB (p.65,
p.74), this color space is automatically transmitted from DPP to EPP
EX, allowing you to print with faithful colors.

If you set Apple RGB, ColorMatch RGB or Wide Gamut RGB, the
image is printed with Adobe RGB color space.

Printing with a wide color reproduction

When the color space (p.65, p.74) is set to Adobe RGB and the image
is printed with the Canon inkjet printer, the color reproduction area
widens, and green and blue in particular are reproduced vividly.

|§| DPP is also compatible for printing with Easy-PhotoPrint Pro (p.68).
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Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint

You can perform the following types of photograph printing with the
Canon inkjet printers compatible with the Easy-PhotoPrint (hereinafter,
“EPP"):

Simple printing of RAW images

Printing with faithful colors

High quality printing using the color reproduction range of Adobe RGB

and a Canon inkjet printer

To perform this printing, it is necessary to first install EPP version 3.5 or
later on your computer.

Select the image to be printed.

Start up EPP.
Select the [File] menu » [Plug-in printing] » [Print with Easy-

PhotoPrint].
Open in Edit window... *O
Open in Edit window (enlarged)...
Close all
Open window #EN
Close window HEW
Save 3#ES
Save As... i3S
Add thumbnail to image and save {3T
Convert and save... #D
Batch process... £
Create new folder... 1t 38N
Page setup... 1+ 3P
Print... #P
Print with detailed setting... {+3D
Contact Sheet Prints... ~¥HP
" D g Print with Easy-PhotoPrint  38E
Add to collection #G
Remaove from collection {+#G

EPP starts up.

In the EPP window, select the [Easy-PhotoPrint]
menu » [Preferences].

Easy-PhotoPrint

About Easy-PhotoPrint...

(

Preferences... %, )

Services >

Hide Easy-PhotoPrint 3H
Hide Others #EH
Show All

Quit Easy-PhotoPrint  3Q

The [Preferences] window appears.

1 In [Print Quality], select [Quality Priority].

Preferences

— = ==

G g

Print Number of copies : 1 ‘3 Copies
Printing Order : ' By Date | :}
Amount of extension of Default | :v]

borderless printing :

Print Quality :

[ ' Quality Priority

( Defaults )
Cancel ) E—Oﬁ-—)

M) }——— Select

Quality
Priority
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Select the [Advanced] tab sheet and check that the

EPP image compensation function is disabled.

@ If not disabled, the operation of the EPP image compensation
function may prevent images being printed with faithful color
reproduction.

Preferences

B A dvanced )

{ Print | Advanced

Image gptimize images automatically
A

pply Rotate/Trimming to the same images in the same manner
When landscape images are rotated depending on the selected
) Rotate Left

) Rotate Right

Layout 1 Always trim when you select the layout with the margins

ESet margins to the minimum when you select the layout

with the margins

E Print filename when you select the index in layout

E Preview all layouts of A4 and Letter
Image ] Select images from multiple folders
Selection

( Defaults )

® ( Cancel ) 'G—Oﬁﬂ'

If checked,
click to
remove the
check mark

Click to
close the
window

Specify the number of sheets to be printed, and then
click [Next].

Click

Click to
increase the
number of
sheets to be
printed

Check that the image compensation function is

disabled, select the paper type and then click [Next].

If checked, click to remove the check marks

Eazy-PhotoPrint

EﬁiﬁhhtoPrim

Select the

Pogee 500 : A4 Paedia Type ; Biwie P Fro 9 Pagel)

8 Specify the layout, and then click [Print].

Lavy-Fhotornt

Select the layout

=» Printing begins.

paper type

Click to print
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? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
The printed image’s color is not what you expected

Change the [Rendering intents when using Easy-PhotoPrint] (p.74) to
[Perceptual] (p.118) and print.

A/

Q> Advantages of printing using EPP

Printing with faithful colors

When the color space (p.118) is set to SRGB or Adobe RGB (p.65,
p.74), this color space is automatically transmitted from DPP to EPP,
allowing you to print with faithful colors.

If you set Apple RGB, ColorMatch RGB or Wide Gamut RGB, the
image is printed with Adobe RGB color space.

Printing with a wide color reproduction

When the color space (p.65, p.74) is set to Adobe RGB and the image
is printed with the Canon inkjet printer, the color reproduction area
widens, and green and blue in particular are reproduced vividly.

|§| DPP is also compatible for printing with Easy-PhotoPrint Pro (p.68).

Printing Photographs with a Printer other than the Canon Inkjet Printers

You can print one image on one sheet of paper.

Select the image to be printed.

Select the [File] menu » [Print].

Open in Edit window... *O
Open in Edit window (enlarged)...
Clase all
Open window 18N
Close window HW
Save *HS
Save As... {35
Add thumbnail to image and save {C#T
Convert and save... ®D
Batch process... 3B
Create new folder... 13N
Page setup... 1+ 3P
( Princ.. #®P )
Print with detailed setting... 3D
Contact Sheet Prints... ~¥P
Plug-in printing »
Add to collection #G
Remave from collection 3G
Delete <
Info... k9|

The [Print] dialog box appears.

Set to photograph printing and print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [Print] button.
Printing begins.
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Organizing Images
This section explains how to delete unwanted images, create folders for
saving images, move or copy images, etc., and organize your images.

Deleting an Unwanted Image

Be aware that you cannot recover deleted images.

Select an unwanted image in the main window.

Select the [File] menu » [Delete].

Open in Edit window... #0
Open in Edit window (enlarged)...
Close all
Open window 3EN
Close window FEW
Save 35
Save As... {+ 385
Add thumbnail to image and save (3T
Convert and save... ®D
Batch process... ¥B
Create new folder... 1+ 3N
Page setup... {+ 3P
Print... #EP
Print with detailed setting... {+3D
Contact Sheet Prints... ~¥P
Plug-in printing [ 3
Add to collection #G
Remave fram collection 11 3G
[ Delete %®<x)
Info... Eq]

The image is moved to the [Trash] and is deleted from DPP.
The images are deleted completely from your computer by
selecting the [Finder] menu » [Empty Trash] on the desktop.

Creating a Folder for Saving Images

You can create a folder for sorting images.

In the folder area, select the location where the new

folder is to be created.

8086 Digital Photo Profi

IIITy,
i1

Folder Collection(0)
v =4 MacOsx
» [A Applications
[F Temporary Items
¥ (& Users
¥ 1§} canon
» [@ Desktop

» | Documents
» (@ Library
[ Movies
L& Music
v e
b N——
> [ Sites
P | % Shared

“) Select the [File] menu » [Create new folder].

" Ea

Open in Edit window... H*0
Open in Edit window (enlarged)...

Clase all

Dpen window N
Close window EW
Save 3#S
Save As... 1+ 385
Add thumbnail to image and save {r3T
Convert and save... #*D
Batch process... #B

( Create new folder... {r3N )

Page setup... {+3EP
Print... P
Print with detailed setting... 4+¥D

The dialog box for entering a folder name appears.

Enter a folder name and click the [OK] button.

The new folder is created in the folder selected in step 1.
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Moving Images

You can move or copy images to a separate folder and sort by shooting
date or themes.

Moving Images in Folders

You can move or copy folders that contain images, and sort the images

)

Introduction

Contents at

Drag the image to be moved or copied.
To move: Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the <option> key
and release when the image is in the destination
folder.

Digital Photo Professiona)

view
Folder
¥ = Macosx
b A Applications
[ Temporary Items
v ¥ Users
v & canon
¥ [ Desktop
| Travel
» (A Documents
P ¥ Library
[ Movies
@ Music
¥ |2 Pictures
v [4 Photo
[0 oo _xx_xx
» [& Public
P [ sites
» [3 Shared

The images are moved or copied to the destination folder.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the Basic
Operation

Advaficed
Op ion

destination folder.
To copy: Drag the folder while holding down the <option> key

Digital Photo Professional

v & Macosx
» [4 Applications
(¥ Temporary ltems
¥ & Users
¥ @ canon
¥ [ Desktop
[ Travel
» | Documents
» |# Library
[® Movies
|8 Music

» | & Public
» [ sites
» [7 shared

=» The folders are moved or copied to the destination folder.

and release when the folder is in the destination folder.
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o Introduction
Organizing Bookmarks

. . You can change a folder name or delete a folder registered in
You can register frequently used folders in bookmarks. [Bookmark]. Contents at

Registered folders appear by clicking the [Bookmark] menu. a Glance

Registering Frequent-Use Folders (Bookmark Registration)

Select the folder for which a bookmark is to be

registered. folder names or delete folders. OpBe?;?on
200 Digital Photo Professiona|
=
Folder Collection(0)
g 1
T i o Advanced
b Bl Dommnts Image Editing
o ° . . and Printing
N . Select Processing
o8 e — Large Numbers
» [3 Shared o L *—-_f-—' of |mages
Select the [Bookmark] menu » [Add]. Editing
The folder selected in step 1 is registered in the [Bookmark] JPEG/TIFF
menu. Images
Select a registered folder from the [Bookmark] menu to display
images in the selected folder in the main window.
Reference
Index

Select the [Bookmark] menu » [Organize].
The [Sort bookmarks] window appears and you can change

Q0
)

—
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3 Advanced Image Editing and Printing

Introduction
Various preferences including advanced image adjustment, automatic Performing Automatic Dust Erasure Processing _____ 61
dust erasure processing, various printing functions for printing out work, ;
cust eras marr:agementgare explaiF:]ed hgre, eared © tF:]e usgr . Compat.lble Cameras............... ..... s s 61 Cg,gle;ntgeat
competent in the handling of third-party image editing software. Automatic Dust Erasure Processing in the Main Window... 62
Manually Erasing Dust (Repair Function)................ 63
Adjusting While Comparing with the Original Image... 49 Erasing Unwanted Parts of an Image (Copy Stamp - E
Changing How the Window is Split.............ccccvveeee.n. 49 FUNCLION).....eiiiiiiiieeecc e 65
Adjusting by Comparing Multiple Images................. 50 Transferring a RAW Image to Photoshop................ 65 Advanced
Displaying an Area Beyond the Set Range as a Setting Work Color Space .........cccoeveevviieeciiieeeeenn. 65 i
Warning Indicator (Highlight/Shadow Warning) ....... ol Printing with Shooting Information.................coc...... 66 T
Performing Advanced Editing............ccccccooeiiinnnnne, 52 Printing a Thumbnail List (Contact Sheet Printing).. 67 Igna(g;gtiit%g
Adjusting White Balance with Color Temperature ..... 52 Printing RAW Images on a High-End Canon Printer.. 68
Tuning White Balance with Color Wheel ................... 52 Printing with a High-End Canon Inkjet Printer ............ 68 Laprzgoecﬁjriitr)]grs
Adj:usting .Dynamic Ran.ge ......................................... 53 Printing with a Large-Format Canon Printer .............. 69 of Images
_Lszmg a Plcture. Style File.......ovviiiiiiiiiii v 53 SPECHYING PrETEIENCES....ooooooooooooooooooooooooeoeooo 20 i
one Curve AdUSIMENt.......cccmurrmreeeess B v o4 General SEtiNGS......cvvveeeeeeeeeeeeeeeee e 70 | JFEC/TIEE
Example of a Tone Curve Operation ...........w..... °F VIEW SEttNGS..oviiiieieeeeei e 72 —
About the RGB Tool Palelte .......................... Wy 2 TOOI Palette .....vuiiiiieee 73
RedUCING NOISE ..., 6 Color Management...........ccceoveeeeeeeeeeeeeeeeeee e, 74 Reference
Correcting Lens Aberration .........cccooeevveviiiiiieveeennnnnn. 57
Compatible Cameras............ccccocviiiiiiiiiii, 57 Index
About EOS 5D Compatible Lenses ............ccccceeeen. 57
About EOS 30D Compatible Lenses ..................... o7
Compatible LENSES....cccoeeeieiiiiiiii 58 @ @
Making COrreCliONS............uvvvvviviviiiiiiiiiiiiiinns 59
About Shooting Distance Information Slider.............. 60 @
Correcting Multiple Images ata Time..........cccceeeee.... 60
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Adjusting While Comparing with the Original Image

You can display before and after versions of an adjusted image in the
same window and adjust while checking the adjustment results.

In the edit window, select the [View] menu » [Before/
after comparison].

| s e wa v sty

The image divides into a left and right window.
The window on the right shows the image after editing.

Change the image display.
Select the [View] menu » [Change up/down/left/right] » [Up/
down].

[ZXals) Dl 7

lmsas somnic 7w 11m, v i

The layout of the two images changes to top and bottom.
The bottom window shows the image after editing.

|§| Images can also be displayed in the edit image window by the same
operation.

Changing How the Window is Split

You can change the display of the image to a single image split in two.

In the edit window, select the [View] menu » [Display
mode] » [Split single image].

T T T T e T T

=» One image is divided and displayed on the left and right or top
and bottom.

@ To switch between top and bottom, and left and right, perform the
same operation as step 2 on the left page.

)
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Adjusting by Comparing Multiple Images

You can synchronize the display position of multiple edit windows and Move the display position.
adjust images while comparing them with each other. If you move the enlargement display position in one of the edit
windows, the enlargement display position will also change in the
In the edit window, display the multiple images to be other edit windows.
compared. To cancel synchronization, select the [Window] menu »

Align the images [Synchronize] again.

Align the images for easy comparison.

Select the [Window] menu » [Synchronize].

Enlarge the image.
Enlarge and display any of the edit windows.

W Dvaital Fhoto Professional_ e ew  Adpitmer Toshs Wndew o W 4 wedsiiR @
GG Er——

— ]

it i Ak 4 20

: g gusiny l‘“‘“w

The other edit windows will also be displayed in the same
position/enlargement ratio.

|§| Synchronization only applies to the enlargement display position
and the enlargement ratio. Adjustments to the images are not
synchronized.

)
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Displaying an Area Beyond the Set Range as a Warning Indicator (Highlight/Shadow Warning)

You can set up a warning indicator in both the highlighted part and the Display the edit window.
shaded part, which is effective for checking the light and dark areas and
preventing excessive adjustment of an image. Where the area on the

Introduction

image has exceeded that set range, you can display the highlighted part Select the [View] menu » [Highlight]. Similarly, select Corg}tlents at
in red and the shaded part in blue. [Shadow]. ablance
On the opened image, if there is an area that exceeds the value
Select the [Digital Photo Professional] menu » entered in step 3, the highlighted part of that area is displayed in Basic
[Preferences]. red and the shaded part is displayed in blue. Operation
Select the [View settings] tab sheet.
Advanced
Operation

Enter the warning value for [Highlight] and [Shadow].

-

Preferences
Advapced
+ General settings View settings | Tool palette Color management - Imag |t|ng
and Pfinting
Grid pitch
" b4 Pixels(8-256)
Processing
Locking selected image L N b
E Images opened in Edit window remain selected in main window argfel umbers
ol Images
Magnification in Edit window g
®) Fit to window O 50% O 100% ) 200%
Magnification when the Edit/Edit image window is double-clicked w J PEEdg/I_T_IgFF
O 50% 100% ) 200%
e l Images
RAW and JPEG
# Display only CR2 images for CR2 and JPEG files of the same name
Sort order in main window
| Retain sort order Reference
Highlight/shadow warning
Highlight 192 | woz-zss
Shadow N ) |
Quick check tool display Index
@ 50% ) 100% (moiré reduction off)
—_—
Cancel \ f 0K ')

Click the [OK] button to close the window. @@

©
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Performing Advanced Editing

This section explains how to use the advanced adjustment function on
the tool palette in the edit window.

Adjustments made using the high-level functions of the [RAW] and
[RGB] tool palettes, as well as the functions of the [NR/Lens] tool palette
are explained in this section.

Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.

Set the color temperature.

———————— [ raw RGE NRiLens ——
‘En’ght‘ness adjustment = |‘

:I!II!II'IIE:I!II'II'II IDDD
‘While balance adjustment | = |‘

I?‘ 2 ' 3 Register...

Color temperature | :] Tune... \I
i .
= (5200 k)——+— Display the value of the

setting
Drag the slider left or right

|§| The adjustment range is 2500 to 10000K (in 100K units).

Tuning White Balance with Color Wheel

White balance can be tuned by moving a cursor in the color direction
shown in the color wheel.

In the [RAW] tool palette, click the [Tune] button.

Tune by dragging a point.
You can also fine-tune your adjustment by directly entering the
adjustment values.

enn ‘White balance fine adjustment
Color tone: —— Enter the values
Color saturation: to set
{ cancel DN - OK )
|
Drag

@ To register adjustment results as personal white balance (p.79),
select a setting other than [Shot settings] from the [White balance
adjustment] list box, and then tune with the color wheel. You cannot
register the adjustment results as personal white balance when you
have selected [Shot settings] from the list box and have done any
tuning.

@ The adjustment range of color tone is 0 to 359 (1 unit in numerical
value input), and the adjustment range of color saturation is 0 to 255
(1 unit in numerical value input).
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Adjusting Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

|Picture Style [ B ;|
= ’Fw‘"—'?— Move downwards
b My Bome Output highlight points
- . Move to the left or right
Input highlight points

1001 e Pl = P’ 4} &

G =

{Uc]lntraSl 1 1 1 I .\7' i 1 1 1

| Linear Move upwards

{C;'ﬂrtm: A ST i Output shadow points

Color saturation:

{D] ] 1 1 ] .? 1 1 1 1

Sh :

{]_]arpness ‘I_Gl 1 1 1 1 1 1 1 1

Move to the left or right
Input shadow points

The horizontal axis shows the input level and the vertical axis
shows the output level.

Using a Picture Style File

A Picture Style file is an extended function of a Picture Style.

With DPP, you can apply to RAW images Picture Style files that you
have downloaded from Canon’s web site effective for various scenes or
Picture Style files created with “Picture Style Editor”. When using a
Picture Style file, save it to your computer beforehand.

Display the image to which the Picture Style file is to
be applied in the edit window (p.11).

Select the [RAW] tab sheet in the tool palette, and
click the [Browse] button.

‘Piclur& Style = ;‘
[ Standard f :1(_ Browse... \I|
¥ | / |

i!li ; /

]
Ll 8

F-ll}.ﬂ -3.0.=6.0 -40 -2.0 0 20 4.0

A

=» The [Open] dialog box appears.

» Select a Picture Style file saved on your computer,
and click the [Open] button.
The Picture Style file you selected is applied to an image.
To apply a different Picture Style file, follow the procedure from
step 2 again.

|§| The Picture Style files that you can apply to the camera are files with
the “.PF2” extension only. Furthermore, you cannot apply Picture
Style files with the extension “.PSE” to an image; however if such a
file is registered in the camera and the image is shot, the image will
display correctly.
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Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.117).

In the tool palette, select the [RGB] tab sheet.

Select the tone curve mode and interpolation

method.
— RAW [RGB | MRiens |
|Tnne Curve assist O+ E2e
Tone curve adjustment ]
RGB R | c_'f_s_? [;”;!
755 '
¥ Curve
Straight P
<control> + click inside
¥ ROERGE the graph to display the
Luminance RGB menu
T ———————
D |
o 255
Erlghtness .I!!!IIIIMIIIlIIII! Di
cnntraSI IIlI'iIIIMIlIiIiIII I:l-\ir
Hue: ||||||I||M|!|I||||! -2 I:l i:
Saturation: :|||:::||D-\|/'||:-|:||| 2 100 -
- [ e —— (o)
Sharpness. \IJ;IIIIIIII!II-III!II- 3 I:l-\:,-

Make adjustments.

Batch adjusts RGB
Adjusts each channel

———+— RrRaw || ReB | NRiens |
|Tone curve assist O P ‘
Tone cpurve adjustment b
RE | R | c__sj [
ZSS/ l
il 'l

. Y
255

Brightness: ..:::....|.\./.|........: 0 l
Contrast: ’.....;...DM...;.;...- 0 i
Hue: s E—Di
Saturation: :|.|==:||D?‘r’-|.:.|:||. Eﬂfi
Sharpness: D'—-Y........:......:... 3 0 i

Click to add a [[] (point)
Adjust by dragging [[]]

The horizontal axis shows the input level and the vertical axis

shows the output level.
The maximum number of [[]] is 8.

To delete a [[]], double-click on the [[].

The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any

adjustments (p.73).

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.73).
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Example of a Tone Curve Operation

Makes medium tones brighter

Makes medium tones darker

Makes tones harder

Makes tones softer

/)

About the RGB Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens] tab sheets according to your editing
requirements.

The [RGB] tool palette functions are the same as ordinary image editing
software, such as tone curve adjustment that is explained here, with
which you can adjust RAW images.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than the [RAW] tool palette, the image
color may be saturated, or the image quality may deteriorate if you
adjust too much. Therefore we recommend for functions other than tone
curve adjustment and automatic adjustment (p.30), that you adjust
images using the same functions available in the [RAW] tool palette.
Refer to Chapter 5 for explanations on functions of the [RGB] tool
palette other than tone curve adjustment.

== Using the tool palette

We recommend that as a general principle you edit RAW images using
the [RAW] tool palette. However, where the adjustment width with the
[RAW] tool palette is not wide enough and you wish to use the special
functions in the [RGB] tool palette, we recommend that you adjust your
images at the necessary lowest limit with the [RGB] tool palette after
having completed basic adjustment with the [RAW] tool palette.

Use the adjustment function of the [NR/Lens] tool palette (p.108) when
reducing noise (p.56) and correcting aberration (p.57) after you have
made any required adjustments with the [RAW] and [RGB] tool palettes.
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Reducing Noise

You can reduce noise that arises in RAW images that have been shot at
night or with a high 1SO speed.
NR is an abbreviation for “noise reduction”.

Select the [NR/Lens] tab sheet from the tool palette
in the edit window or edit image window.

Adjust an image.
—{ RAW  RGE | NRflens }———

= |

RAW

Luminance noise
D | IR O A O O N A B | 10

Chrominance noise ( i
D G L IR A R A R N B B | 10

TIFF or JPEG

Chrominance noise

Drag the sliders right

Lens aberration correction Tune... |
Peripheral illumination OFF
Distortion OFF
Chromatic aberration OFF
Color blur OFF

You can set a noise reduction level from within a range of 0 to 10.
The larger the setting, the larger the noise reduction effect.

Click the [Apply NR] button.
Noise reduction is applied to the image and the image is
redisplayed.

Display the image in the [100% view] or [200% view].
You can check the noise reduction effect.
In the [50% view] or [Fit to window] display, it may be difficult to
check the noise reduction effect.

"2 Additional information

The noise reduction function does not work

Noise reduction cannot be applied when [Viewing and saving RAW
images] (p.70) is set to [High speed] in the [Preferences] window.
Select [High quality] to reduce noise.

® To check the noise reduction effect, enlarge the image and
display it
Because noise reduction effect is difficult to see in the [50% view] and
[Fit to window] displays, use [100% view] or [200% view] to check the
noise reduction.

® Luminance noise reduction is not available for sSRAW images
You can only reduce chrominance noise for sSRAW images. You
cannot reduce luminance noise.

|§| If [Luminance noise] has been set, resolution may be reduced
along with reduction of noise.
If [Chrominance noise] has been set, color bleeding may occur
along with reduction of noise.
You can set the batch processing settings for noise reduction
using [Default noise reduction settings] in the [Tool palette] tab
sheet in Preferences (p.73). This is particularly useful for applying
noise reduction to all the images in a folder at once, such as
batch noise reduction for images with high ISO speeds. However,
where images have a recipe attached, the noise level recorded in
the recipe is applied.
For a list of tool palette functions, refer to p.108.
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Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

Please note that you can only correct RAW images which you have
taken with the compatible cameras and lenses listed below. JPEG or
TIFF images cannot be corrected.

Compatible Cameras

EOS-1Ds Mark Il EOS-1D Mark IlI EOS-1D Mark Il N
EOS-1Ds Mark Il EOS-1D Mark I EOS-1Ds

EOS-1D EOS 5D EOS 40D

EOS 30D EOS DIGITAL REBEL EOS DIGITAL REBEL

XSi/450D XTi/400D DIGITAL

About EOS 5D Compatible Lenses

For images shot with the EOS 5D whose firmware version has been
changed to 1.1.1, the aberration correction function can be used with all
lenses under “Compatible Lenses”.

However, for images shot with version 1.1.0 or earlier, the following
lenses are not compatible.

Lenses not compatible with firmware version 1.0.5 or earlier
EF 14mm f/2.8L Il USM EF 50mm f/1.2L USM
EF 85mm f/1.2L Il USM EF 16-35mm f/2.8L Il USM
EF 70-200mm f/4L IS USM —

Lenses not compatible with firmware version 1.1.0
EF 14mm f/2.8L Il USM EF 50mm f/1.2L USM
EF 16-35mm f/2.8L Il USM EF 70-200mm f/4L IS USM

About EOS 30D Compatible Lenses

For images shot with the EOS 30D whose firmware version has been
changed to 1.0.6, the aberration correction function can be used with all
lenses under “Compatible Lenses”.

However, for images shot with version 1.0.5 or earlier, the following
lenses are not compatible.

Lenses not compatible with firmware version 1.0.4 or earlier
EF 14mm f/2.8L Il USM EF 50mm f/1.2L USM
EF 85mm f/1.2L Il USM EF 16-35mm f/2.8L Il USM
EF 70-200mm f/4L IS USM EF-S 18-55mm f/3.5-5.6 IS
EF-S 55-250mm /4-5.6 IS —

Lenses not compatible with firmware version 1.0.5
EF 14mm f/2.8L Il USM EF 16-35mm /2.8L Il USM
EF-S 18-55mm /3.5-5.6 IS EF-S 55-250mm /4-5.6 1S
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Compatible Lenses

EF 14mm f/2.8L USM
EF 14mm f/2.8L Il USM
EF 20mm f/2.8 USM
EF 24mm f/1.4L USM
EF 28mm /1.8 USM
EF 35mm f/1.4L USM
EF 50mm f/1.2L USM
EF 50mm f/1.4 USM
EF 85mm f/1.2L USM
EF 85mm f/1.2L Il USM
EF 100mm /2.8 Macro USM
EF 135mm f/2L USM

EF 180mm f/3.5L Macro USM

EF 200mm /2.8L USM

EF 200mm f/2.8L Il USM
EF 16-35mm f/2.8L USM
EF 16-35mm f/2.8L Il USM
EF 17-35mm f/2.8L USM
EF 17-40mm f/4L USM

EF 24-70mm f/2.8L USM
EF 24-105mm f/4L IS USM

EF 28-70mm f/2.8L USM

EF 28-135mm /3.5-5.6 IS USM
EF 28-200mm f/3.5-5.6

EF 28-200mm f/3.5-5.6 USM

EF 28-300mm f/3.5-5.6L IS USM
EF 70-200mm f/2.8L USM

EF 70-200mm f/4L USM

EF 70-200mm f/2.8L IS USM

EF 70-200mm f/4L IS USM

EF 100-400mm f/4.5-5.6L IS USM
EF-S 60mm /2.8 Macro USM
EF-S 10-22mm f/3.5-4.5 USM
EF-S 17-55mm /2.8 IS USM
EF-S 17-85mm f/4-5.6 USM
EF-S 18-55mm f/3.5-5.6

EF-S 18-55mm f/3.5-5.6 |l

EF-S 18-55mm f/3.5-5.6 USM
EF-S 18-55mm f/3.5-5.6 Il USM
EF-S 18-55mm /3.5-5.6 IS
EF-S 55-250mm f/4-5.6 IS

You can also correct RAW images taken with the compatible lens
even when the extender is attached.

The aberration correction function is not available for images shot
with combinations of camera/lens other than those given under
“Compatible Cameras” and “Compatible Lenses”. They are
therefore not displayed and cannot be used.
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Making Corrections

You can make corrections to any of the four aberrations as below, either

one at a time or simultaneously.
Peripheral illumination
Distortions

Chromatic aberration (color fringing which occurs in the periphery of

an image)

Color blur (blue or red color blur which sometimes occurs at the edge

of the highlighted area of an image)

In the tool palette, select the [NR/Lens] tab sheet.

Click the [Tune] button.
! RAW | RGE | 'NRjlens }

= |
RAW

Luminance noise 9—
D I R O R O O RO BN B | 10

Chrominance noise 6—-
ﬂ LI N R A R A R I 10

TIFF or JPEG

Chrominance noise =r
0

10

Apply NR

Lens aberration correction ( Tune... ]

Peripheral illumination OFF
Distortion OFF
Chromatic aberration OFF
Color blur OFF

The [Lens aberration correction] window appears.

Checkmark the items to be corrected.

enn ens aberration correction - IMG_1001.CR2]

-» The image is corrected and redisplayed.

Check the results of corrections to peripheral illumination or
distortions in the full view.

© Check the results of corrections to chromatic aberration and color
blur by clicking the area on the image you want to check. In the
top right of the window, the area is displayed at 200% in the
enlargement display section (p.113).
You can lessen the degree of correction by moving the slider to
the left for the item you want to correct.
You can respectively correct red chromatic aberration with the [R]
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.

Click the [OK] button.
The [Lens aberration correction] window closes and the result of
the corrections is applied to the image in the edit window and the
image is redisplayed.
The result of the settings of the [Lens aberration correction]
window is also displayed in the tool palette.
In the main window, the [g)'.v] mark is displayed on the image to
indicate the lens aberration corrections (p.105).
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About Shooting Distance Information Slider

When correcting RAW images taken with the EOS-1Ds Mark Ill, EOS-
1D Mark Ill, EOS 40D or EOS DIGITAL REBEL XSi/450D, the slider is
set automatically according to the shooting distance information
saved to the image.

However, if EF 50mm /1.4 USM, EF 85mm f/1.2L USM or

EF 28-70mm f/2.8L USM is used, it is set automatically to the right
end at infinity position. You can then minutely adjust the distance by
operating the slider while looking at the screen if the shooting
distance is not infinite.

When correcting RAW images taken with the EOS-1D Mark Il N,
EOS-1Ds Mark Il, EOS-1D Mark Il, EOS-1Ds, EOS-1D, EOS 5D,
EOS 30D or EOS DIGITAL REBEL XTi/400D DIGITAL, it is set
automatically to the right end at infinity position. You can then
minutely adjust the distance by operating the slider while looking at
the screen if the shooting distance is not infinite.

[Shooting distance information] slider is applied to all the correction
items with check marks.

Correcting Multiple Images at a Time

Select multiple images to correct in the main window. Display tool
palette by selecting [View] menu » [Tool palette]. If you perform
correction procedures (p.59) when tool palette is displayed, you can
apply the same corrections to all the images selected in the main
window.

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.37).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise
reduction of the noise reduction function (p.56).

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p-29).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by
adjusting the color tone (p.27) and/or the color saturation (p.88) to
make the color deeper.

The result of [Color blur] correction cannot be detected
[Color blur] correction is effective for correcting blue or red color blur

which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

® The periphery of the image may be truncated when [Distortion]

correction is made.

@ For a list of the [Lens aberration correction] window functions, refer

to p.113.
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Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera Click the [OK] button to return to the main window.
that can attach this data, can be used to automatically erase dust spots. The [3] mark (p.105) is displayed on an image from which dust

spots have been erased.

Compatible Cameras

EOS-1Ds Mark Il EOS-1D Mark Il EOS 40D

EOS DIGITAL REBEL EOS DIGITAL REBEL L = o _ )

XSi/450D XTi/400D DIGITAL £ Additional information

] ) ) ) The dust-erased image can be reverted to its original condition
In the main window, select an image appended with at any time
Dust Delete Data. A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
Select the [Tools] menu » [Start Stamp tool]. always revert to the original image by clicking the [Undo] button in the
The copy stamp window appeatrs. copy stamp window or performing the “Re-Editing an Image”

procedure (p.39).

® Check dust erasure in the copy stamp window
Check dust erasure in the copy stamp window. Images before dust
oo ||t erasure are displayed in other windows and you will be unable to
- check them.

® Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

® The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
i camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.63) or the copy stamp function (p.65).
The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.38).

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

P ¥als] ¥ 172 MG 0030.CH2 (3456 x 2304]

Dust spots are erased in a single operation.
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> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, refer to p.114.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].
Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

Place the dust spot to be erased within the [O] and

_ _ _ Introduction
You can erase dust spots in an image by selecting them one by one.

In the main window, select the image you want to
erase dust spots.

Select the [Tools] menu » [Start Stamp tool].
The copy stamp window appears.

When the image has redrawn itself, double-click the
point from where dust is to be erased.

ana ¥ 112 MG 0050.CAZ (3436 x 2304)
1 100% vew [ Full sire vew
{_ Aoty Duit Delete Data )

- w= D_ouble-
=B click

The display changes to 100% view.
The display position can be changed by dragging.

Click the button that matches the dust spot to be
erased.
If the dust spot is dark in color, click the [ ] button, and if
the dust spot is light in color, click the [ ] button.
When you move the cursor over the image, the dust erasure
range appears as [Q].

click.

Bre ¥ 171 NG DOR0.CRZ 3434 x 2304]

Click

% The dust spot within the [O] is erased.

© Click on another part of the image to continue erasing dust spots
in the image.

® To erase dust in another part of the image, click the button
clicked in step 4 again to cancel dust erasure processing and
perform the operation again from step 3.

@ When the dust spot cannot be erased, [(§)] is displayed.

Click the [OK] button to return to the main window.
The [ 2] mark (p.105) is displayed on an image from which dust
spots have been erased.

Contents at
a Glance

Basic
Operation

Advanced
Operation

Ad ced
Imag iting
and Pfinting

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00
©

63




? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.65).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.39).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.38).

\

~
-

/

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, refer to p.114.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1to 3in “Manually Erasing Dust (Repair
Function)” (p.63).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <option> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [8,] mark (p.105) is displayed on a corrected image.

Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Photoshop.

Select the [Tools] menu » [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
a time, refer to p.81.

@ Compatible versions of Photoshop are 7.0 or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.117) is added. The ICC profile
contains information about [Preferences] (p.74) or work color
space set for each image as described below and the appropriate
color information is relayed to Photoshop.

Setting Work Color Space

A different work color space (p.118) from the default settings (p.74) can
be set for each image.

Select the [Adjustment] menu » [Work color space] »
color space to be set.

? A color space setindividually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.74), this
default setting will not be applied and the individually set color space will
remain.

Ay

~

== The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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Printing with Shooting Information

You can freely lay out one image on one sheet of paper and print
together with titles and shooting information, etc.

Introduction

“@ To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply] e
Select one image to be printed. button is clicked (excluding the contents of the [Text] tab sheet). The ontents at

. : . o a Glance
settings can be applied to another image when printing.
Select the [File] menu » [Print with detailed setting]. -
@ You can set printer profiles (p.74). Ope?;lc?on
Specify the required settings for printing, and then If (IZMYK s%ilrlnulation has been set, the image is printed in the set
click the [Print] button. colors (p.74).
. . Advanced
Switches the settings tab sheet Operation

#| IMG_0001.CR2

'{ Printer | Image Text Settings 3 Ad Ced
Printer : j Imag |t|ng
and Pfinting
Media .
ad Processing
Media orientation La]’ge NumberS
CSveal of Images
Editing
JPEGI/TIFF
Images
CMYK profile:
: Reference
Apply )( Cancel | @ Index

Print preview

The image can be moved by dragging. @ @
Drag the four corners of the image to change the size.
For the shooting information, click [E]] on the [Text] tab sheet

and select the necessary items in the window that is displayed.
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Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper.

Introduction
@ To maintain the settings

Select images to be printed in a thumbnail list. The settings of each tab sheet in step 3 are memorized when the [Apply] c
button is clicked (excluding the contents of the [Text] tab sheet). The S
. . settings can be applied to another image when printing.
Select the [File] menu » [Contact Sheet Prints]. J PP g P g
; ; i Pt @ You can set printer profiles (p.74) R
Specify the required settings for printing, and then =t printer p p-r4). o . Operation
click the [Print] button If CMYK simulation has been set, the image is printed in the set
' _ _ colors (p.74).
Switches the settings tab sheet Advanced
Operation

Contact Sheet Prints

'~{ Printer | Image = Text Settings ,-

Printer : Ad ced
Imag iting
Media and PPinting
A4
Media orientation: Process'ng
@ Portrait Large Numbers
CLandscape Of |mageS
Editing
JPEG/TIFF
Images
Reference
Select profile
W} Cancel
‘ Index
Print preview

00
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Printing RAW Images on a High-End Canon Printer

Printing with a High-End Canon Inkjet Printer

For high-end Canon inkjet printers that are compatible with the printing
software Easy-PhotoPrint Pro, you can print with DPP by a simple
operation that has the following features:

Simple printing of RAW images

Printing in faithful colors

High quality printing using a wide color space of Adobe RGB, etc. and

the wide color reproduction range of a high-end Canon inkjet printer

To print with DPP, first install Easy-PhotoPrint Pro version 1.3 or later on
your compulter.

Select the [File] menu » [Plug-in printing] » [Print
with Easy-PhotoPrint Pro].
Easy-PhotoPrint Pro starts up.

Specify the required settings for printing, and then
print.

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
Function set in DPP that is not applied to printing

Specified CMYK simulation (p.74) is not applied.

A/

-@> Advantages of printing with Easy-PhotoPrint Pro

Printing with faithful colors

When the color space is set to SRGB or Adobe RGB (p.65, p.74), this
color space is automatically transmitted from DPP to Easy-PhotoPrint
Pro, allowing you to print with faithful colors.

If you set Apple RGB, ColorMatch RGB or Wide Gamut RGB, the
image is printed with Adobe RGB color space.

Printing with a wide color reproduction

When the color space (p.65, p.74) is set to Adobe RGB and the image
is printed with a high-end Canon inkjet printer, the color reproduction
area widens, and green and blue in particular are reproduced vividly.
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Printing with a Large-Format Canon Printer

You can use DPP to print with the DPP-compatible Canon large-format
imagePROGRAF printer. To print with DPP, first install the
imagePROGRAF Print Plug-In for Digital Photo Professional on your
computer.

Select the [File] menu » [Plug-in printing] » Plug-In
for the printer you use.
The Plug-In starts up.

Specify the required settings for photograph
printing, and then print.

? Additional information

A single image can be printed at a time

You can print a single image selected in DPP at a time. When printing
multiple images, perform printing for each image individually.
Functions set in DPP that are not applied to printing

Specified output resolution (p.70) and CMYK simulation (p.74) are not
applied.

A/

-@> Advantages of printing with the imagePROGRAF Print Plug-In

Printing with faithful colors

When a color space is set (p.65, p.74), it is automatically transmitted
from DPP to the Plug-In, allowing you to print with faithful colors.

Printing with a wide color reproduction

When the color space setting (p.65, p.74) is set to a color space wider
than sRGB (such as Adobe RGB), the color reproduction range of the
imagePROGRAF printer is fully utilized and the image is printed with
a wider color gamut than an image that has an sRGB color space,
with green and blue in particular being reproduced vividly.
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Specifying Preferences

You can change the various functions of DPP in the Preferences
window. Check the contents of each window and set.

Also, depending on the item, a detailed explanation may be available,
so refer to each window.

Select the [Digital Photo Professional] menu »

[Preferences].
The [Preferences] window appears.

Select the tab sheet, specify the settings, and then
click the [OK] button.

Preferences

4({ General i | View settings Tool palette | Colorr gement }

Startup folder

) Last displayed folder
() Specified folder

Browse... MacOSX fUsers /canon/Desktop

Save recipe

(# Display message when adding file
() Add to file automatically

Viewing and saving RAW images

#) High quality (recommended)
| View images at high speed {moiré reduction off}
) High speed View/save RAW images at high guality
Moiré is reduced and the NR tool palette can be used

JPEG image guality |

| Remave block noise and mosquite noise

[_! Display thumbnails at high quality

Default value of output resolution

350 dpi(1-60000)

At EOS Utility startup

| Edit image window enabled at EOS Utility startup

4 Cancel ) ( OK 3

General Settings

You can specify the folder that opens when DPP is started up, image

quality of displayed and saved RAW images, etc.

Preferences

—{ General settings | View settings Tool palette Colar management

Startup folder

(®) Last displayed folder

) Specified folder

Browse... MacOSX [Users /canon/Desktop

Save recipe
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JPEG image quality
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[ Display thumbnails at high quality

Default value of output resolution
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Viewing and saving RAW images

You can select from two types of image quality for displaying/saving
RAW images: high image quality with false color reduction processing
and noise reduction function (p.56) used, or high speed without false
color processing and noise reduction function used.

[High quality]
False color reduction processing is automatically applied, and the
image can be displayed/saved as a false color reduced-high quality
image. Furthermore, you can use the noise reduction function (p.56)
to reduce the luminance noise and chrominance noise.
Because the effects of the false color reduction processing and noise
reduction function are difficult to see in the [50% view] or [Fit to
window] display of the edit window and edit image window, use [100%
view] or [200% view] to check.
We recommend that you normally set [High quality] for a balance
between image quality and display speed.

[View images at high speed (moiré reduction off)] of [High quality]

If you checkmark [View images at high speed (moiré reduction off)],
when the image is displayed in the edit window or the edit image
window, false color reduction processing is not applied.
As the [View images at high speed (moiré reduction off)] setting is the
same as [High quality] other than for display of the image, the image
undergoes false color reduction processing when it is saved and the
noise reduction function is also available.

[High speed]
Since false color reduction processing is not applied, the display
speed of a RAW image in the edit window or the edit image window in
the [100% view] or [200% view] enlargement display, and the time it
takes to save a RAW image is less than in [High quality].
You cannot use the noise reduction function (p.56).
Depending on the image, it may be displayed/saved with false color
or noise being noticeable.

? What is the difference between the [High quality] and [High
speed] displays?

The display image quality of [High quality] and [High speed] is the same
except when the image is displayed in the [100% view] or [200% view]
enlargement display in the edit window or the edit image window.

» JPEG image quality

[Remove block noise and mosquito noise]

? You can improve the quality of a JPEG image by reducing the noise
that is likely to occur when RAW images are converted to JPEG
images and saved (p.38, p.80).

This setting is also effective for JPEG images that have been saved
with a different name.

[Display thumbnails at high quality]
You can have the thumbnails for JPEG images automatically displayed
at high quality. If you checkmark [Display thumbnails at high quality],
all subsequent JPEG image thumbnails imported into DPP will be
displayed at high quality.

? The extent of the improvement in noise reduction

The higher the JPEG image’s compression rate, the more noise is
reduced. When the compression rate is low, the effect of noise reduction
is negligible.

Default value of output resolution

You can set the resolution for RAW images converted and saved as
JPEG or TIFF images (p.38, p.80).
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View Settings

You can specify settings relating to the display.

Preferences

[ General settings | Miew settings | Tool palette Color management -

Crid pitch
64 Pixels(8-256)

Locking selected image

E Images opened in Edit window remain selected in main window

Magnification in Edit window

®) Fit to window () 50% ) 100% ) 200%

Magnification when the Edit/Edit image window is double-clicked

—-

) 50% ® 100% ) 200%
RAW and JPEG
E Display only CR2 images for CR2 and JPEG files of the same name

Sort arder in main window

! Retain sort order

Highlight/shadow warning

Highlight 192 ez-255 [N
Shadow 0 (0-64) |
Quick check tool display

@ 50% ) 100% {maoiré reduction off)

Cancel

) €

Sort order in main window

You can set the order of images which have been rearranged in the
main window to be maintained or not maintained (p.19).

If you checkmark the checkbox, the order of the rearranged images is
maintained even if you quit DPP or select another folder in the folder
area.

If you remove the check mark, the order of the rearranged images is not
maintained and reverts to the previous order when you quit DPP or
select another folder in the folder area.

Highlight/shadow warning

Highlighted/shaded areas that exceed the set range can be displayed
on the image as warning indicators (p.51).
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Tool Palette

You can specify settings for the tool palette.

Preferences

Ceneral settings View settings | Tool palette |

Color m

gement

Default settings of RGB Tone curve mode

Tone curve mode

M RGERGE ) Curve

) Luminance R G B () Straight

Histogram display
(") Before adjustment
®) After adjustment

Tool palette display in Edit Image Window

Interpolation method

®) Docking display
) Floating display

Modified Picture Style settings

E Retain settings of each Picture Style

Tool palette display mode

[_| Same for Main window and Edit window

Default noise reduction settings

RAW luminance noise reduction: 0] 5. ) il L
RAW chrominance noise reduction: 0]} E?. RS
TIFF/JPEG chrominance noise reduction: {0} 9—

(L i

) e

Default settings of RGB Tone curve mode
You cannot apply changes to the settings until you re-open the folder.

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

Modified Picture Style settings

You can select whether the [Color tone], [Color saturation], [Contrast]

and [Sharpness] settings will be changed or retained, when you change

the Picture Style.

© If you checkmark the checkbox, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be changed to match the
camera’s preset settings, when you change the Picture Style.

® If you remove the check mark, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be retained, even if you
change the Picture Style.

Default noise reduction settings

You can set a default beforehand for the noise reduction level. Further,
for images not having a recipe attached, the default set here for noise
reduction level is applied. However, for images with a recipe attached,
the noise level recorded in the recipe remains as it is and the default for
noise reduction level set here is not applied.

=)= Advantages of setting a noise reduction default

In instances where the same level of noise occurs in several images,
such as images shot with high ISO speed, setting an appropriate default
noise reduction setting enables you to apply a batch noise reduction
default to all the images displayed in DPP. This eliminates the need to
apply noise reduction to each individual image.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advapced
Imag iting
and Pfinting

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00

73




Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

Preferences

- General settings View settings Tool palette | Color management }

Default settings of Work color space
) sRGB

") Adobe RGB

) wide Gamut RGB

) Apple RGB

) ColorMatch RGB

CMM settings for print
For display :
%) sRGB
) Monitor profile
ENG/Library/ColorSync/Profiles/Displays/Acer AL1922-1CAB49B4.icc
Printing profile:
" None 5 ]

Rendering intents:

CMYK simulation profile: Rendering intents: | |

None )

Rendering intents when using Easy-PhotoPrint
) Perceptual

(®) Relative Colorimetric ‘ ‘

Cancel f 0K 3

Default settings of Work color space

You can select from five types of color space (p.118) that is applied as a
default setting in RAW images. Color space that has been set is applied
as the color space when a RAW image is converted and saved (p.38,
p.80) or printed (p.39, p.42, p.44, p.66 to p.69).
If you have changed the setting, and you restart DPP, the new setting
is applied as the default setting color space.
You can check color space that has been set in an image in the edit
window (p.106) and the edit image window (p.110).

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

|§| You can set a color space that is different from the default settings
for each image (p.65).

® Display setting (color setting of the monitor)
Where a profile (p.117) is attached to the monitor you are using, you can
display an image in more faithful colors by setting the profile.

Checkmark the [Monitor profile], click the [Browse] button and in the
dialog box that appears, select a profile for your monitor.

ALy

5@5 Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.
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Setting of printing profile (color setting of the printer)

Where a profile (p.117) is attached to the printer you are using to print
images, you can print an image and simulate the colors displayed on
screen by setting the profile. The profile that has been set is applied to
all printing (p.44, p.66, p.67) except for printing using a Canon inkjet
printer (p.39, p.42) or linked printing (p.68, p.69).

? The adjustment function of the printer driver should not be
used

Even if you set a printer profile, if you use the color adjustment function
of the printer driver, the image may print in colors different from those
displayed on screen.

-I\@/E Automatic settings for printing using EPP EX, EPP, and
linked printing

If you are printing using a Canon inkjet printer (p.39, p.42) or using
linked printing (p.68, p.69), a profile is set automatically even when the
[Printing profile] setting is not performed. This allows you to print faithful
colors easily.

Setting of CMYK simulation profile

You can select the color when printing in the CMYK environment of a
printing machine, etc. from four types of profiles (p.118) and perform
simulation on screen.
When CMYK simulation has been set, [CMYK] appears (p.103, p.106,
p.110) in the bottom of the main window, edit window and edit image
window, and colors can be checked.
To temporarily cancel CMYK simulation, press the <space> key.

Rendering intents when using Easy-PhotoPrint
You can set a rendering intent (matching method) (p.118) for printing
using Easy-PhotoPrint (p.42).

The rendering intent is ordinarily set to [Relative Colorimetric].

» When colors with [Relative Colorimetric] are not satisfactory, set to
[Perceptuall.
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4 Useful Functions for Processing Large Numbers of RAW Images

Introduction
For users shooting a large amount of RAW images, the convenient
function of batch processing large amounts of RAW images is explained
Contents at
here. a Glance
Utilizing Adjustment Contents (Recipe)................... 77 R
Saving Recipes as a File.......ccccoovevveiiiiiiiiiii e, 78 Operation
Loading and Pasting ReCIPeS..........cccevvvvvviiiieeeeeeennnns 78
Copying a Recipe and Applying to Another Image..... 78 Advanced
. ) Operation
Batch Apply White Balance to Images (Personal White
Balan(?e) O IR VIR e, 79 Adionoed
Registering Personal White Balance.......................... 79 |Image Editing
. \ and Printing
Applying Personal White Balance .............cccccceeeeeen. 79 —
Batch Save as JPEG or TIFF Images (Batch Lg’rréocsiggrs
PrOCESSING)...uu i iciiiiiie e 80 of Iméges
Batch Transfer Images to Image Editing Software.. 81 E—
Batch Change the File Name of Images.................. 82 J'Tn'ﬁgéL'SFF
Changing the File Name of Images in the Order in the
MaiN WINAOW .......coveiiiiiiiiiiiiiiiiieeeee e eeeeeee e 82
Reference
Index

-
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.vrd”) and loaded and

applied to another image.

You can edit images efficiently by selecting and adjusting one image
from images shot with the same shooting environment and batch
applying the adjustment results to a large number of images.

000 ¥ IMG_0015.CR2
e RAW RGE | MRMens r—

| Brightness adjustment =3

|Whjle balance adjustment - |
s s et it

Shot settings B Tune.. )

|Picture Style ey |

Standard |¢]I” Browse... )

-10.0 -8.0 -6.0 -4.0 -2.0 O 20 4.0
Contrast: "‘“‘""‘9—“—“‘
(o) T i G

| Linear

Color tone: "—-—-"9'-—“““
o e e
Color saturation: .-—-—-—-9—-—-—-—-—
{0 I e

Sharpness: —-9-—-—-—-—-—-——-—-\
1) ! R

RAW image data

- !

I \N
Lvrd

Contents adjusted using the tool
palette can be handled

individually as a recicpe file
(extension “.vrd").

|§| The adjustment contents of JPEG or TIFF images can be saved as
a recipe file (extension “.vrd”) and loaded and applied to another
image in the same way as with RAW images (p.84, p.99).

? Additional information

Recipe data includes tool palette contents

Recipe data includes adjustments made with the tool palette ([RAW],
[RGB] and [NR/Lens]). For this reason, other editing content such as
trimming or dust-erasure (copy stamp) is not included in the recipe
data.

Recipes adjusted with the [RAW] tool palette can only be applied
to RAW images

Adjustments in the [RAW] tool palette, which can only be made for
RAW images, are not applied to a JPEG or TIFF image even if they
are pasted.
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Saving Recipes as a File Copying a Recipe and Applying to Another Image
Select an edited image, and then select the [Edit] You can copy a recipe of an edited image and then apply it to another
menu » [Save recipe in file]. image.

The [Save] dialog box appears. Select the image from which arecipe is to be copied

Select the destination folder, enter a file name, and and then select the [Edit] menu » [Copy recipe to
then click the [Save] button. clipboard].

The recipe is copied.
‘2 Check the contents of a recipe file by pasting to an image Select the image to which the recipe is to be applied

o _ , and then select the [Edit] menu P [Paste recipe to
When you do not know the contents of a recipe file, paste it to an image

and check the settings in the tool palette. When only a few settings are SeIeCted, Imag e]j .
adjusted, we recommend you use a file name that describes the The recipe is applied to the image.

contents or that you separately record the adjustments as text
information.

Loading and Pasting Recipes

Select the image to which arecipe is to be applied,
and then select the [Edit] menu P [Read and paste
recipe from file].

The [Open] dialog box appears.

Select arecipe and click the [Open] button.
The recipe is applied to the image.
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Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific . :

shooting environment can be registered as personal white balance. You Applyl ng Personal White Balance

can then perform efficient white balance adjustment by applying this In the main window, select the image to which white
personal white balance to a large number of RAW images shot in the balance is to be applied

same shooting environment.
Click the [Tools] button on the toolbar.

The tool palette appears.

Registering Personal White Balance
Click the personal white balance number button that

Adjust' the vyhlte balance (p.25, 9.26, p.52). is to be applied.
To adjust white balance, select a setting other than [Shot
settings] from the [White balance adjustment] list box (p.25). You ——{RAW | RGE NR/Lens
will be unable to register the adjustments if you select [Shot \Efiﬂhtﬂm adjustment [ D] ;\
SettlngS]. IIIIIIIIIIIWIIIIIIIIIII {}DD
In the [RAW] tool palette, click the [Register] button. [Whice baance adjustment B
The [Register personal white balance] dialog box appears. BP: | : WRegister.. )
Select the button number to be registered from the Rayiigls L s IS
list and click the [OK] button.
BN [#| Register personal white balance = ‘PictureSnde |£J‘
Register current setting in personal white balance [ Standard ! :] I'L Browse... \I
Current setting: Click white balance ; i

[ Custom 1 f :D

( Cancel

rh—ll].(] -8.0 -b0 -40 =-20 DO 2.0 4.0

Caontrast:
{u] I 1 I 1 v 1 I 1 1
| Linear
‘{:E;:Jllur tDne 1 1 1 1 v 1 1 1 1
Color saturation: =
v 1 1 1 1

(]} | 1 I 1

Sharpness:
{]_] ‘l_Glllllllll

Personal white balance is applied to all the selected images.
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Batch Save as JPEG or TIFF Images (Batch Processing) .
You can batch convert and save edited RAW images to highly versatile In the processing dialog box, click the [Terminate]
JPEG or TIFF images. button.
The images are saved as separate images, so the RAW images remain
Contents at
unaffected. a Glance
In the main window, select multiple images to be
converted. Basic
Operation
Click the [Batch process] button on the toolbar
(p.103). Ad q
The [Batch settings] window appears. Op\é?gtcign
Specify the required settings, and then click the
[Execute] button. Advanced
S D ? [Save] cannot be performed ";‘na(?%ﬁgt'i‘;”gg
e ooraiens e — In the [Batch settings] window, you cannot perform [Save] or [Save As]
Pl e = (p.37, p.98) to edited RAW images. Procedsing
IMG_0006.CR2 mgequly ————————————8 1 Larg bers
IMG_0007.CR2 ¥ of Im ges
IMG_0008.CR2 Output setting A %.
MC_0010.CR2 Ouputresoien 350 a9 Embed iCC profle -@>  Skillful batch saving
o002 CR2 e : > : o Editin
MG_0013.cR2 s s © While saving is being performed, you can continue working in JPEG/TIFF
R 0015.0n s mon 7 another window Images
S Since the saving function operates independently in the background,
S you can continue with an operation in another window such as the
main window or the edit window during the saving process. Reference
® New file name To convert all images and save, do not select an image in the
Commm Commm - main window
T ok e If you do not perform step 1 and perform step 2 with no image ke
image ransfer sertings selected in the main window, all the images displayed in the main
2 o window will be converted and saved. -
( Convert RAW images only ) ( Cancel € Execure )
The processing dialog box appears and saving begins. ﬁl If you have selected [New file name] in [File name], [Sequence @ @
When all the images are saved, the [Terminate] button appears in number] has to be set.
the processing dialog box. By saving as explained on this page, a trimmed image (p.35,
p.92) or dust-erased image (p.61 to p.65, p.94 to p.98) actually

becomes a trimmed image or dust-erased image.

For a list of [Batch settings] window functions, refer to p.115. 80



Batch Transfer Images to Image Editing Software _
Introduction
You can transfer multiple images to image editing software. The Select Photoshop CS.
software used here as an example is Adobe Photoshop CS. In the [Open] dialog box, select a Photoshop CS file or an alias
_ _ _ _ and click the [Open] button. Contents at
In the main window, select multiple images to be The [Open] dialog box closes and [Image transfer settings] in the a Glance
transferred. [Batch settings] window is set to Photoshop CS.
Click the [Batch process] button on the toolbar Checkmark [Open image using software]. Basic
(p.103). image transfer settings Operation
The [Batch settings] window appears. @Dﬂm image using software
. . . . Adobe Photoshop CS Browse...
Perform settings required for transferring (e.g. file — Advanced
format). ( cancel ) Bxecute ) Operation
Click the [Browse] button. Click the [Execute] button. Advanced
e The processing dialog box appears and batch transfer begins. Image Editing
G000 2 Sw“"‘" e -»When the first image has been transferred, Photoshop CS starts and Printing
mgfgg:-g;i File farmat. : up and transferred images are displayed in transferred order.
IMG_0005.CR2 Kind of file Exif-JPEG %) Proceflsin g
R 00722 sl T Larg bers
MG_0008.CR2 Output setting : of Im@ges
mgigg?zﬁ;i Output resolution | 350 dpi [ Embed ICC profile
IMG_0011.CR2 Resize setting B i _ i 1 ..
IMG_0012.CR2 :vﬁslihze o - Edltlng
i R - jEditing._
IMC_0015.CR2 (3456 pixel]. {2304 pixel) A |mages

Lotk s

File Name

) Current file name
String

Reference

(®) New file name

String Sequence number

DPP_ © oool [ save sequence number
Bx: DPP_000LJPG, DPP_0002 JPG

Image transfer settings |ndeX

g Open image using software

Cancel (’ Execute ')

The [Open] dialog box appears. @ @

81




Batch Change the File Name of Images

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].
The rename window appears.

Specify the required settings and click the [Execute]
button.

MacOSX/Users /canon/Pictures /Photo/xxxx_xx_xx

File Name Extension

(2

DPP ] Shooting Date/Time 3 Seguence number :J De not change 3

Basic Settings Format settings

Sort Sequence number
@ Fit to main window 0001 Jsave sequence number
" File Name

: Shooting Date/Time Shooting Date/Time

! & W+ [ Month Day Year 3
__ Copy & Rename ir MM-DD-YY -
MacOSK/Users /canonDesktop @Insen underbar

Original File Modified File Name
IMG_0001.CR2 DPP_09-13-06_0001.CRZ
IMG_0001.JPG DPP_09-13-06_0002.JPG
IMG_0002.CR2 DPP_09-13-06_0003.CR2 |
IMG_0002.JPG DPP_09-13-06_0004.JPG !
IMG_0003.CR2 DPP_09-13-06_0005.CR2
IMG_0003.JPG — (DPP_09-13-06_0006.JPG
IMG_0004.CR2 DPP_09-12-06_0007.CR2Z
IMG_0004.JPG DPP_09-12-06_0008.JPG
IMG_0005.CR2 DPP_09-13-06_0009.CR2 ‘.‘
IMG_0005.JPG - DPP_09-13-06_0010.JPG
[a ;) an € )

Processing begins and the file names are changed.

? Changes cannot be made when the file name is duplicated

If a file name in red text has appeared in [Modified File Name], the file
name has been duplicated. Changes cannot be made if even one file
name has been duplicated. Change the settings so that duplication does
not occur.

|§| You cannot start up the rename tool from the [Collection] window
(p.33, p.104).
For a list of the rename window functions, refer to p.116.

Changing the File Name of Images in the Order in the Main Window

When you change the order of the images in the main window (p.19),
you can change in one operation the names of the files for the images,
in the order they were rearranged.

Change the order of the images in the main window
(p-19).

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].

Select [Fit to main window].

MacOSsx

File Name

pPP =} Shooting

Basic Settings

'Sort

f*) Fit to main window ]
. File Name

() Shooting Date/Time

Specify the required settings (p.116).
To copy an image, checkmark [Copy & Rename].

Click the [Execute] button.
The file names are changed and the order in the main window is
maintained.
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5 Editing JPEG and TIFF Images

Introduction
DPP is software mainly aimed for advanced RAW image editing, but it
also has JPEG and TIFF image editing functions. Here, the editing and
saving of JPEG and TIFF images are explained. Cgrgstle;ntgeat
Editing JPEG and TIFF Images...........ccceevvvieeeeeeenn. 84 R
About the RGB Tool Palette ........ccccoeeeeeeeiiiiiiiieeeeeenn. 84 Operation
Automatically Adjusting Brightness and Color (Tone
CUINVE ASSISE) ... 85 Advanced
Adjusting Brightness and Contrast................ccceuve.... 86 S R
Adjusting Color Tone Using Click White Balance....... 87
Adjusting Hue, Saturation and Sharpness.................. 88 |imageEditing
Tone Curve AdjUStMEeNt...........cc.coveveeveeereeeeereeeeeea 89 | and Printing
Adjusting Dynamic Range ..........ccccooevviviiiiiiiiiiinnneeenn. 90 m
RedUCING NOISE .....ceveveiveeeecie e, 91 Laggfe"':ggggrs
TrmMmMING an IMage......cccoovveeeiviiiieiiiceeeiee e 92
Performing Automatic Dust Erasure Processing ..... 94 JPE’§PFF
Compatible Cameras............cccceeeeeeeeeeiiieeeeeeceenn, 94 Imees
Automatic Dust Erasure Processing in the Main
WINAOW ... 95 Reference
Manually Erasing Dust (Repair Function)................ 96
Erasing Unwanted Parts of an Image (Copy Stamp
T T (1o 1) R SRPOTN 98 Index
Saving Editing Results............ccccceei i, 98
Saving Editing Content to an Image................c.......... 98 @ @
Saving as a Separate Image .............cccceevvvvvvveeeeeennn, 99
Applying Editing Contents to Another Image........... 99 @
PHNTING ..o 99
Re-Editing an Image.........ccoeiiiiiiiiiiiieeeeiieeeeeeeee 99 83



Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the [RGB] and [NR/Lens] tool palettes.

Because adjustment made with the tool palette (recipe) only changes
the image processing conditions, the “original image data itself” remains
unaffected. Therefore, there are no problems with image deterioration
that arise with editing and you can readjust your images any nhumber of
times.

a8 & * IMG_D015.JPC
" RAW | RGB | NRiLens |
B g =)
Tone curve adjustment |
R r | c]& |
>

255

Tone curve assist

¢

l‘

)

s

] < I \N
. - [vrd |
Brightness: O Y e —
ARERRERR T (IRRERETRT] -
e

Contents adjusted using the tool
palette can be handled
individually as a recicpe file
(extension “.vrd”) (p.77, p.99).

Hue:
Saturation:

Sharpness:

In DPP all the adjustments (image processing conditions information)
made with the tool palette can be saved in the image as data called a
“recipe” (p.98), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.vrd”) (p.77, p.99).

About the RGB Tool Palette

With the functions in the [RGB] tool palette, you can adjust JPEG and
TIFF images with the same functions as ordinary image editing
software.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than the [RAW] tool palette, the image
color may be saturated, or the image quality may deteriorate if you
adjust too much. Therefore, take care not to adjust your images to an
excessive degree.

You can adjust RAW images with the functions in the [RGB] tool palette.

However, for functions other than tone curve adjustment (p.89) and
automatic adjustment (p.85), we recommend adjusting RAW images
using the same functions available in the [RAW] tool palette.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.117). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click the desired automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most

images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.
— RAW [RGB NR/Lans |
[l e ' 1 |7+ [z ——Reverts the tone curve
Tone curve adjustment [ o] to the original Settings
e ¢ | [ s ]
255 71 High
Standard
0 \ |
0 255
Eﬂghtﬂess trrrirerrfrerrnrnnn Dz
cuntraSL trnrrrereYrerrerrent D?
Hue: TR rrereYrnern et |2! DE
Saturarinn: trrnrrreneYrnrnrenn Lgi lDD 3
Sharpness: Q—m,: 0 ?

The tone curve changes as adjusted.

@< Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

¢ Images which have been shot with the proper exposure

» Images where the brightness is unbalanced

* Images which are too dark

¢ Images which have extreme backlighting

® If you click the [] button, the tone curve as well as the [Hue] and
[Saturation] revert to the default settings. Take care when adjusting
the [Hue] and [Saturation] individually (p.88).
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)

Introduction
- - - Brightness: Move the slider to the right to make an image
Adjusting Brightness and Contrast 9 . g . g
brighter and to the left to make an image darker.
The brightness and contrast of an image can be adjusted. Contrast:  Used to adjust modulation and degree of contrast Contents at
of color. Move the slider to the right to make a Glance
- RAW | RGB | NRiens contrast of an image stronger and to the left to
Tone curve assist O o+ 25 make contrast weaker.
| : [0 [ [io)] B
Tone curve adjustment .- | Operation
R < | c ||
255 r I
Advanced
Operation
Advanced
Image Editing
and Printing
= Processing
% ik Large Numbers
) J of Images
. ~—|  Drag the sliders left or
0 255 iaht E g
: o "9 JPEGIFF
Brightness: 0 Tl | es
Contrast: o +-—— Enter numerical values
Hue trrrr et LEI DE
Saturatlun AR R R IR AR R R @ ll:”:l z Reference
Sharpness: Q—LEJ 0 ?

Index

|§| The adjustment range is —100 to +100 (in 1-stop increments when

entering a value). 86



Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Click the [[#]] button.

p————— RAW | RGB | NRfLens
‘Tnne curve assist [ [ HE+ HEb|
Tone curve adjustment L-l_-, [
Rlcle]

255

"R N
|
i

0

Erighmess Y ey
Contrast: ’_Q_‘
bty rrene

Hue trrrr et 'EJ
Sa‘[ufﬂtlﬂ‘n. AR R R IR AR R R [EJ ll:”:li
Sharpness: e—‘@

=

G Gl G| (o) (5

[==]

Click on a point that is to be the standard for white.

ana #| Digital Photo Professional - [ MacDSX/Users /canen/Pictures [Photo/ xxoo_xx_xx /IMG_DD10.JPG |

5471, 216, 2SR

The coordinates of the cursor position and the RGB values (8-bit
conversion)

=» The color of the image is adjusted with the point you selected as
the standard for white.

@ If you click on another point in the image, the white balance is
adjusted again.
To finish click white balance, click the [] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

|§| The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.
The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.73).

)

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Reference

Index

87



Adjusting Hue, Saturation and Sharpness

You can adjust hue (tone) and saturation and make the overall

atmosphere of an image harder or softer.

RAW | RGB | NRilens |
‘Tane curve assist [ il || & I'Ebi|
Tone curve adjustment &= ||
e - [ c ¢ ]
e ;
255
0 -
0 255
EﬂghTHESS: trrrrrrerrYrnenrenn I:l \:F
Contrast: "__'@—_“ ol
trrrrereYrrerenrenn L
—
Hue LERARN I8 e |'b?-l| I:l \L
Saturation:
LESLRE IR [RERR RS !
Sharpness: [ ] ~1
p [N AR REE RN NE) |.__b_,J I:l 1:'-

Drag the sliders left or right

e (6] 100 ’:“—} Enter numerical values

Hue: Move the slider to the right to make color tones
more yellow, and to the left to make color tones

redder.

Saturation: Move the slider to the right to make the color
deeper, and to the left to make the color weaker.

Sharpness: Move the slider to the right to make an image
harder, and to the left to make an image softer.

? Sharpness is unnatural

Adjust sharpness with the window view set to [100% view], [50% view]
or [200% viewl]. If the view is set to [Fit to window] (full view), the

sharpness will seem unnatural.

ﬁl The adjustment range is —30 to 30 for hue, 0 to 200 for saturation,
and 0 to 500 for sharpness (in 1-stop increments when entering a

value).
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Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.117).

Select the tone curve mode and interpolation

method.

RAW | RGB | NRiLens |
|T0ne curve assist il fra's Eb‘
Tone curve adjustment -
ReB | R |G| | [#]
255
v Curve
Straight o
<control> + click inside
v RGERGEB the graph to display the
Luminance R G B menu
0| )
o 255
ErightnESS: trrrrrreerYreenerennn I:l :-,‘-
cnntraSt IIlIIiIIIl\If:'IlliIIIII D :i;-
Hue trrerrreerYreenerennn '\2' D L
5 ; — o ]
Saturation: RTINS i RNINLIAT 3 100 L
= D..—.——. _’-.-
Sharpness \f,llllllllllllllllllll -\2' D '\:"

Make adjustments.
Batch adjusts RGB

Adjusts each channel
— [ raw |[*ReB~| NRLens |
|Tone curve assist £ &@‘
Tone curve adjustment b
@ < ¢ ) 7|
255 f I
i

\ | |
25.5 .

Brightness: m o i
Contrast: m o 1
Saturation: u.m:uD-\r’u.u.u:u. Eﬁi
Sharpness: m 3 —gl

Click to add a [] (point)
Adjust by dragging [[]

The horizontal axis shows the input level and the vertical axis
shows the output level.

The maximum number of [[]] is 8.
To delete a [[]], double-click on the [[].

The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any
adjustments (p.73).
The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.73).
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Adjusting

Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright

points in an imag

e can be adjusted.

Move downwards
Output highlight points

Output
highlight point
numerical
value

RAW | RGB| | MNRLens |
Tone curve assist | 'Ara'™ | ‘
\ [0 | o+ izo)
Tone curve adjustment |
=5
T o A
RGE__ 2 OB

T 259

Move to the
right
Input shadow
points

Output shadow —
pointnumerical
value

Input shadow —
point numerical
value

— 0

= 25577
ﬂi m.immm- 2
Contrasy mm 2 E
Hue: nmulllil'“'""' lal,_D;
Saturation: m.g.......... &'ﬂ{é
Sharpness: R |_t’_JI 0 -i—

Move upwards
Output shadow points

— Reverts the

image to the
original
settings

— Move to the

left
Input highlight
points

— Input highlight

point numerical
value

The horizontal axis shows the input level and the vertical axis shows
the output level.

The setting range of shadow points is 0 to 247 (in 1-stop
increments when entering a value).

The setting range of highlight points is 8 to 255 (in 1-stop
increments when entering a value).

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.73).
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Reducing Noise

You can reduce noise that arises in JPEG and TIFF images that have

been shot at night or with a high ISO speed.

Select the [NR/Lens] tab sheet from the tool palette
in the edit window or edit image window.

Adjust an image.

— RAW | RGB | NRflens }———

g |

RAW
Luminance noise =
] 10
Chrominance noise
] 10
TIFF or JPEG
Chrominance noise @—
1] (e I A I 10
Apply NR

Lens aberration correction

Peripheral illumination

You can set a noise reduction level from within a range of 0 to 10.

Drag the slider right

The larger the setting, the larger the noise reduction effect.

Click the [Apply NR] button.

Noise reduction is applied to the image and the image is

redisplayed.

Display the image in the [100% view] or [200% view].
You can check the noise reduction effect.
In the [50% view] or [Fit to window] display, it may be difficult to
check the noise reduction effect.

? To check the noise reduction effect, enlarge the image and
display it

Because noise reduction effect is difficult to see in the [50% view] and
[Fit to window] displays, use [100% view] or [200% view] to check the
noise reduction.

@ If [Chrominance noise] has been set, color bleeding may occur
along with reduction of noise.
You can set the batch processing settings for noise reduction
using [Default noise reduction settings] in the [Tool palette] tab
sheet in Preferences (p.73). This is particularly useful for applying
noise reduction to all the images in a folder at once, such as
batch noise reduction for images with high ISO speeds. However,
where images have a recipe attached, the noise level recorded in
the recipe is applied.
For a list of tool palette functions, refer to p.108.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers

of Images

E g
JP IFF
| es

Reference

Index

00

91



Trimming an Image

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical.

Also, when aspect ratio information is attached to an image shot with the
EOS-1Ds Mark 11l or EOS-1D Mark lll, the trimming range based on the
aspect ratio information is displayed.

Select the image to be trimmed.

Select the [Tools] menu » [Start Trimming tool].
The trimming window appears.

When the image has redrawn itself, select a ratio and
drag the trimming range.

S # 1/1 MG 0001PG (3456 x 2304]

Full screen

(o« (= _)— Cancel

Select a
!(”w ;'504 - trlmming
width _ Height = .
"""" o I N—.E ratio
=_- r" Drag the
—% trimming
range

(O S04 15 3026, 1EN0 ) = (1969 x 132611 190

The trimming range can be moved by dragging.
You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

List of aspect ratios (width : height)

v Free
1:1
3
2:3
4:3
3:4
5:4
4:5
A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

[Free]: You can trim an image to any size, regardless of the
selectable ratio.
[Custom]: You can trim an image at the specified ratio.

' Click the [OK] button to return to the main window.
=» The trimming range frame is displayed in the trimmed image
(p.105).
»When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its timmed form.

)
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? About trimmed images

The trimmed range can be reverted to its original condition at

any time

A trimmed image is displayed or printed as a trimmed image.

However, since the image is not actually trimmed, you can always

revert to the original image by clicking the [Reset] button in the

trimming window or performing the “Re-Editing an Image” procedure

(p.99).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.105).

* Edit window:

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when saved as a separate
image

The trimmed JPEG or TIFF image actually becomes a trimmed image
when saved as a separate image (p.99).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to an image shot with the
EOS-1Ds Mark Il or EOS-1D Mark I, the set trimming range based
on the aspect ratio information is displayed. However, since the image
is not actually trimmed, you can change the trimming range or revert
to the condition before trimming.

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.112).

The image is displayed in its trimmed condition.

A/

> Convenient functions of the trimming window

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming
window. With the trimmed image displayed, click the [Copy] button
and then click the [Apply All] button. This will apply the trimming range
to all the images selected when the trimming window is displayed.

|§| For a list of the trimming window functions, refer to p.112.
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Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera Click the [OK] button to return to the main window.
that can attach this data, can be used to automatically erase dust spots. The [3] mark (p.105) is displayed on an image from which dust

spots have been erased.

Compatible Cameras

EOS-1Ds Mark Il EOS-1D Mark Il EOS 40D

EOS DIGITAL REBEL EOS DIGITAL REBEL L = o )

XSi/450D XTi/400D DIGITAL £ Additional Information

] ) ) ) The dust-erased image can be reverted to its original condition
In the main window, select an image appended with at any time
Dust Delete Data. A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
Select the [Tools] menu » [Start Stamp tool]. always revert to the original image by clicking the [Undo] button in the
The copy stamp window appeatrs. copy stamp window or performing the “Re-Editing an Image”

procedure (p.99).

® Check dust erasure in the copy stamp window
Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

® Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

® The [Apply Dust Delete Data] button cannot be clicked

p— Even with an image that has Dust Delete Data attached to it in the
; camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing
In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots

- depending on the type of dust. If this occurs, erase those dust spots
Dust spots are erased in a single operation. using the repair function (p.96) or the copy stamp function (p.98).
The image becomes a dust-erased image when saved as a
separate image
The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.99).

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

- Tali) F 1/ MG 0050 I [ 1456 & 2304
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> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, refer to p.114.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].
Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one. Place the dust spot to be erased within the [O] and
click.
In the main window, select the image you want to — _ _
erase dust spots. e
Select the [Tools] menu » [Start Stamp tool]. oo e

The copy stamp window appears.

. . . O e Click
When the image has redrawn itself, double-click the oo s
point from where dust is to be erased.

ann ¥ 12 MG 0050 P [1456 = 2304]

Double-
click

=» The dust spot within the [Q] is erased.
Click on another part of the image to continue erasing dust spots
in the image.

©® To erase dust in another part of the image, click the button
clicked in step 4 again to cancel dust erasure processing and
perform the operation again from step 3.

@® When the dust spot cannot be erased, [(3)] is displayed.

L 150 i 1 i s s

The display changes to 100% view. Click the [OK] button to return to the main window.

The display position can be changed by dragging. The [&] mark (p.105) is displayed on an image from which dust

. spots have been erased.
Click the button that matches the dust spots to be P

erased.
If the dust spot is dark in color, click the [ ] button, and if
the dust spot is light in color, click the [ ] button.

When you move the cursor over the image, the dust erasure
range appears as [Q].

)
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.98).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.99).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.99).

\

~
-

/

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <g8> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, refer to p.114.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1to 3in “Manually Erasing Dust (Repair
Function)” (p.96).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <option> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [8,] mark (p.105) is displayed on a corrected image.

Saving Editing Results

Saving Editing Content to an Image

All the contents (recipe) adjusted with the tool palette (p.84 to p.91) as
well as the trimmed range (p.92) and dust-erasure (p.94 to p.98)
information can be saved to a JPEG or TIFF image, or to a separate
JPEG or TIFF image.

Select the [File] menu » desired item.

Open in Edit window... *O
Open in Edit window (enlarged)...

Clase all

Open window N
Close window HW
Save 3ES

Save As... {35

Add thumbnail to image and save {THT
Convert and save... ®D
Batch process... 3B

Create new folder... 13N

Page setup... 3P

Print... 3P

Print with detailed setting... {4+ 3D
Contact Sheet Prints... ~¥P

Plug-in printing »
Add to collection #G

Remave from collection 3G

Delete <
Info... k9|

Your adjustments are saved to the image.
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Saving as a Separate Image

If a JPEG or TIFF image is adjusted with the tool palette (p.84 to p.91)
and then saved in the same way as a RAW image as described below,
the image can be saved as a separate image with the adjustments
(recipe) applied to it.
Furthermore, if a trimmed image (p.92) or dust-erased image (p.94 to
p.98) is also saved in the same way, it actually becomes a trimmed or
dust-erased image.

Saving as a JPEG or TIFF Image (p.38)

Batch save as JPEG or TIFF images (batch processing) (p.80)
By saving as a separate JPEG or TIFF image as explained above, the
adjustments made with the tool palette are applied, and some image
deterioration that accompanies editing/saving occurs as when editing
with ordinary image editing software.

Applying Editing Contents to Another Image =

You can copy the adjustment contents (recipe) of JPEG and TIFF
images that have been adjusted with the tool palette and apply them to
another image with the procedures below, in the same way as with RAW
images.

Applying adjustment contents to another image (p.37)

Utilizing adjustment contents (recipe) (p.77)

Printing
Edited JPEG and TIFF images can be printed with the procedures
below as with RAW images.

Printing (p.39)

Printing with shooting information (p.66)

Printing a thumbnail list (contact sheet printing) (p.67)

Printing RAW images on a high-end Canon printer (p.68)

Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.84 to p.91), so the “original image data itself”
remains unaffected. Also, the trimming range or dust-erasure
information of a trimmed image (p.92) or dust-erased image (p.94 to
p.98) is simply saved to the image.

For this reason, you can undo any adjustments saved (p.98) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu » desired item.

Rotate Left #L
Rotate Right 3R
Add check markl HF1
Add check markz HF2
Add check mark3 HF3
Clear check mark HF4
st

Work color space >
Tone curve assist - Standard

Tone curve assist - High

Revert to last saved settings 32
Revert to shot settings ~37

The image reverts to the conditions of the selected item.
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Reference

This reference section has been provided to enhance your experience
using DPP.

It contains various troubleshooting solutions, how to delete DPP from
your computer, explanations of the various windows and a glossary.

An Index is provided at the end of the chapter for you to easily find
o information you are looking for.
Troubleshooting.........ccuiiiiiiiiiiii e 101
Deleting the Software (Uninstalling) ...................... 102

List of Main Window (Folder Window) Functions .. 103
List of Main Window (Collection Window) Functions... 104
Image Frame Information in the Main Window and Edit

Image WINdOW...........ooiieiiiiiiiiieeeeeeee e 105
List of Edit Window Functions ..............ccccevveeeene., 106
List of Tool Palette Functions ................c..cccceeeeeee 107
List of Quick Check Window Functions................. 109
List of Edit Image Window Functions .................... 110
List of Convert/Save One Image Window Functions 111
List of Trimming Window Functions....................... 112
List of Lens Aberration Correction Window Functions 113
List of Copy Stamp Window Functions.................. 114
List of Convert/Save Multiple Images Window (Batch
Processing) FUNCLONS..........ccoviiiiiiiieeeceeeeeei, 115
List of Rename Window Functions........................ 116
GlOSSAIY ..ovviiieeiieee e 117
INAEX ... 119
About This Instruction Manual .............................. 123
Trademark Acknowledgments..............ccooeeeeeeen. 123
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Troubleshooting

If DPP is not operating correctly, refer to the items below.

Introduction

Installation could not be completed correctly

You cannot install software unless you are logged into an account with
Administrator privileges. Log in again into an account with
Administrator privileges. For how to log in and how to specify
Administrator settings, refer to the User’s Manual for the Macintosh
computer you are using or for OS.

DPP does not work

DPP does not operate correctly on a computer if its system
requirements does not meet. Use DPP on a computer with compatible
system requirements (p.3).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Quit
any applications other than DPP.

Images do not display properly

Images that are not supported by DPP do not display. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2 and 2.21 compatible images and TIFF images other than Exif
compatible images may not display properly (p.3).

When a dust-erased image (p.61 to p.65, p.94 to p.98) is displayed in
a window other than the copy stamp window, it is displayed as it was
before dust erasure was performed. Check dust-erased images in the
copy stamp window.

An image could not be adjusted

The JPEG and TIFF images cannot be adjusted using the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.107).

A recipe could not be pasted (applied) to another image

You cannot paste (apply) rotation (p.10, p.23, p.103, p.109, p.110),
trimming (p.35, p.92), dust erasure (copy stamp) (p.61 to p.65, p.94 to
p.98) of an image to another image as a recipe. Trim the image or
erase dust of the image using the copy/paste function in each window
and rotate each image individually.

The adjustment contents (recipe) of RAW images that has been
adjusted with the [RAW] tool palette cannot be applied to JPEG or
TIFF images (p.107).

Color appears weak in the image when viewed with
other software

A RAW image which has a color space other than sRGB set (p.65,
p.74) and is then converted and saved as a JPEG or TIFF image will
appear weak in color when viewed in software that is only compatible
with sSRGB color space. In this case, set the RAW image color space
to SRGB, convert again to a JPEG or TIFF image and save, and then
view this image.
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The colors of the image displayed on screen and
the colors of the printed image do not match

If the color of the monitor that displays an image is not adjusted
correctly, or if a profile for a printer that is to print images, has not
been set up, the color of the image displayed on screen and the color
of the printed photograph may differ greatly. If the color of the monitor
that displays images is corrected (p.74) and a profile for a printer is
set up correctly (p.74), the color of a printed photograph and the color
of an image on screen can be more closely matched. Using a Canon
printer (p.39, p.42) or linked printing (p.68, p.69) automatically sets up
printer profiles, so you only need to set the color of the monitor to
bring the colors closer together.

When printing using Easy-PhotoPrint and the Easy-PhotoPrint
automatic compensation function and the various types of image
adjustment functions are operating, colors are not printed correctly.
Cancel all Easy-PhotoPrint image adjustment functions (p.43).

Even if you set a printer profile, if you use the color adjustment
function of the printer driver, the image may print in colors different
from those displayed on screen. Do not use the color adjustment
function of the printer driver.

Printing a large number of images in batches cannot be performed

If a large number of images are printed in batches, printing may stop
in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.

A file remains in the folder after images are deleted

Delete [CRW_YYYY.THM] (camera index display image) if it remains
in the folder from which images have been deleted (p.45).
* Numbers are entered for [YYYY] in the file name.

The image information does not display

A JPEG image set to Adobe RGB and shot with the EOS 10D and
EOS DIGITAL REBEL/300D DIGITAL may not display image
information (p.10, p.21).

Deleting the Software (Uninstalling)

Quit any applications before uninstalling the software.

Log into the account used when installation was performed.

When you have moved the folders and the software to be deleted to
the Trash, select the [Finder] menu » [Empty Trash] and empty the
Trash. You cannot reinstall the software until you have emptied the
Trash.

Display the folder in which the software is saved.
Open the [Canon Utilities] folder.

end ~ Applications =
[« » ][5 = m|| 3~ Q

f’l Network P ﬁ‘f

| & ; o

4 Macos_10.4 ‘
| i Mac0s_10.
=y ‘ Mail OmniGraffle OmniOutliner

L Q @

Preview QuickTime Player Safari

—i
| 150 Data_01

System Preferences

| usic
1 [ Pictures = -
— TextEdit Urilities Canon Utilities

v
[ 37 items, 217.24 GB available 7

Drag the folder for the software to be uninstalled to
“= the Trash.

» Select [Finder] menu on the desktop » [Empty Trash].

The software is deleted.
When uninstallation ends, restart your computer.

® You cannot retrieve data that you have emptied into the Trash and

deleted, so be particularly careful when deleting data.
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S E——

List of Main Window (Folder Window) Functions .10 .
Shows/hides the tool palette (p.107) Check marks (p.18)
Shows/hides the folder area Selects all images Removes check marks (p.18)
Switches to the edit image Cancels selection of allimages  Folder path Image rotation (90 degree units) CErl S At
window (p.110) | | a Glance
@/ Digital Photo Prpfessiongl File [dit View Bookmark Adjustment Tools Window Help ‘
1 Digital Photo Professional - [ MacOSX/Users/canon/Pictures/Photo/xxxx_xx_xx ]
Toolbar* .

) o5 Batch conversion/ Basic
[Collection] tab sheet saving (p.80, p.81) e Wi
[Folder] tab sheet*® — o

LAP i:rT[iJc:r(ai?: \slems
T Advanced
'IDesktov Operation
[ Travel
il
l:l :z:::s Advanced
¥ [ pictures Image Editing
”“'{:"ifxx_n_xx and Printing
» (@ Public
» 3 Shared = Processing
Large Numbers
Folder area*z 1 . IMG_0006.CR2 ﬁ;nz : 7 wljc,uooa.cnz R ,_,","Eig,cic'?ac,”, Tj{t@g;kg of |mag es
i Editing
= JPEG/TIFF
— Images
“’ e ([ il [i01] _——— O] B
IMG_0011.CR2 Rt I IMCD § . IMG_0014.CR2 ~ IMG_0015 .CR2
Reference
) Index
Information display*s — (1841, B71): 196, 198, 202 High quality Re‘:ipe dara: Yes quberufimages. 15 Number of selected images: 1 CM\‘Ki//j— CMYK SImUlatlon
_ | \ , display (p.74)
Display mode** Number of selected images
Recipe attachment status (p.77) Number of displayed images @ @
*1 To switch between show/hide, select the [View] menu » [Toolbar]. *4 The item selected in [Viewing and saving RAW images] (p.70) of the @
*2 The images inside the folders selected here are displayed in a [Preferences] window is displayed. —
thumbnail list on the right. *> You can switch between the [Folder] and [Collection] windows.

*3 Displays the coordinates of the cursor position and the RGB values (8-bit
conversion) when click white balance was performed with the tool palette. 103



List of Main Window (Collection Window) Functions (=33

Shows/hides the tool palette Check marks
Selects all images Removes check marks

Switches to the edit im?ge Cancels selection of all images ‘ Image rotation (90 degree units)
window

|‘; Digital Photo Prpfessiongl File [dit View Bookmark Adjustment Tools Window Help EE o |Wed 3:13 PM Q
ene Digital Photo Professional - [ Collection]
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Toolbar

[Collection] tab sheet
[Folder] tab sheet

Batch conversion/ Basic

—‘ saving Operation
r Folder Collection(14)

e J . y Advanced
— Operation
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@ MGolRCR2 m @3 IMG_0004.CR2 m 2 l@m  Moomscz . |gm IMG_0D07.CR2
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Image Frame Information in the Main Window and Edit Image Window .10.p.31)

Information displayed when [Large thumbnail] (p.10) is selected

Digital Photo Professional - [ MacOSX /Users/canon

806

® ®

Clear all

Select all

Folder

Collection(0)
Check mark v 2 MacOSX [y
(p 17 p 18) b | A Applications d .}E COpy Stamp mark
, =R A—— (p.61to p.65, p.94 to
¥ |k Users p.98)
v 8 canon Lens aberration
» [ Desktop correction mark (p.59)
2 Travel
» | Documents . .
Sl Trimming range*®
= Movies (p-35, p.92)
Brightness adjustment —| - Musi
value*l (p.24 ¥ = Pictures
alue** (p.24) v BB Fhows Aperture*3
3 saemor_x_xx
b & Public
P | Sites
> [ shared
’ RAW adjustment mark*1 *4

White balance icon*1 (p.25) File name

RGB adjustment mark*® *>
Unsaved editing content mark
Shutter speed*3

Image type*?

*4 Displays in an image edited with the [RAW] tool palette in the edit
window and the edit image window.

*5 Displays in an image edited with the [RGB] tool palette in the edit
window and the edit image window.

*6 When aspect ratio information is attached to an image shot with the
EOS-1Ds Mark Il or EOS-1D Mark I, the image is displayed as a
trimmed image.

*1 Does not display with [Small thumbnail].

*2 Displays in RAW+JPEG images displayed as a single image (p.20).
[RAW] is displayed in RAW images. (In [Small thumbnail] (p.10), [R] is
displayed.)

*3 Does not display with [Medium thumbnail] or [Small thumbnail].
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List of Edit Window Functions .11, p.23

Introduction

Path and file name of image Tool palette*! (p.107, p.108)
(1ala) %/ Digital Photo Professional - [ MacOSX /Users /canon /Pictures,/Photo/xxxx_xx_xx/IMG_0001.CR2 | eTeTE [# IMG_0001.CR2 ] Contents at
| RaW | RGB  NRiLens a Glance
| Brightness adjustment 'E]|
S AR 0.00
|Whil: balance adjustment ®| Basic
s e B
[ Shot settings Hv}( Tune... )
Picture Style - | Advan Ced
| =] Operation
| Standard h?wi( Browse... )
e
// Advanced
P A Image Editing
i 1 and Printing
IR e e e
Contrast: ) i
B . Processing
! Linear
Y Large Numbers
5 : N
o e of Images
Cal ion:
(mm e
e W Editing
JPEG/TIFF
Images

Reference

(1576, 1021 ) : 157, 165, 189 High guality RAW / Adobe RGB CMYK% iy
: 1 A T S = |ndeX
Information display*? Display mode** CMYK simulation display (p.74)
Image color space*3 and work color space (p.65, p.74) @ @
*1 To switch between show/hide, select the [View] menu » [Tool palette]. *3 RAW images are displayed with [RAW]. @
*2 Displays the coordinates of the cursor position and the RGB values (8- *4 The item selected in [Viewing and saving RAW images] (p.70) of the
bit conversion). [Preferences] window is displayed.
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List of Tool Palette Functions |
Introduction
RAW Tool Palette (p.23) RGB Tool Palette (p.55)
Sy ¥ IMG_0001.CR2 Y ¥ IMG_0001.CR2
———| RaW | RGB  NRiens " RaW | RGB | NRiLens Automatic adjustment Contents at
|Erighrness adjustment |3|| . . |Tcne curve assist [@@@Hﬁ (tone curve assist) (p3o, p85) a Glance
o — J— Brightness adjustment (p.24) e ~— -
e a e D #1— Click white balance (p.87) Basic
- ) ] 255 Operation
1| 2| 5 [ b White balance adjustment
| ([ shot settings B wwne. 3| (p.25, p.26, p.52) —— Tone curve adjustment
| (p-54, p-89) Advanced
| Picture Style 13." Op eration
— WIC soe. | [ 'Clure Style settings (p.24, p.53) - Dynamic range adjustment (p.90)
B Advanced
y : Image Editing
R : . Dynamic range adjustment (p.53) and Printing
| “T00 3.0 --E:.G T R I J 4 LPrOCSSSng
Contrast: e —— Contrast adjustment (p.27) e ) b ag%elm:r;esers
B : - b RRCED [ “= | Brightness and contrast
[ Linear ey Linear setting (p.27) Contral e o ;
Color tane: ) i B gl - adjustment (p.86) =
0) L i Color tone and color saturation L ’; B o Editing
LEler salmen =) adjustment (p.27) . it = =1 Hue and Saturation adjustment JPEGITIFF
(0 e ) ) Saturation: “m”@“m“ lEJ 100 |4 (p 88) Images
Pty R Sharpness adjustment (p.29) Sharpnesd Pr—(o] o[ :
Sharpness adjustment (p.88)
Reference
Enlargement display position*! Enlargement display position*! "
ndex
*1 If an image is displayed enlarged, the enlargement display position can @
be moved by dragging. The enlargement display position appears when N—

[Docking display] (p.73) has been set and the edit image window (p.110)
has been enlarged.
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NR/Lens Tool Palette (p.56)
(When a RAW image is selected)

& &8 |# IMG_1001.CR2

—— RAW  RGB | NRflens }——
i |
RAW

.
Luminance noise reduction for
) RAW images (p.56)

\

Chrominance noise reduction for
- RAW images (p.56)

Chrominance noise 9—
D LI IR R T A R B B R | 10

TIFF or JPEG

Chrominance noise =
o

10

[ Apply vk ——— Apply NR button (p.56)
r D
Lens aberration correction
Peripheral illumination OFF
Distortion orf [— Lens aberration correction (p.59)
Chromatic aberration OFF
Calor blur OFF

Enlargement display position*!

*1 If an image is displayed enlarged, the enlargement display position
can be moved by dragging. The enlargement display position appears
when [Docking display] (p.73) has been set and the edit image
window (p.110) has been enlarged.

NR/Lens Tool Palette (p.91)

(When a JPEG or TIFF image is selected)

& & & |® IMG_1001.jpg
———— RAW | RGB |“NRfLens ]7
= |
RAW
Luminance noise r -
o 10
Chrominance noise .r -
1] 10
TIFF or IPEC

Chrominance noise 9——-———
0 r BT e 10

il S 1 J

| Lens aberration correction

I k- heralillumin
Diste Lioy

o

L_ualor |

Chrominance noise reduction for
JPEG and TIFF images (p.91)

— Apply NR button (p.91)

Enlargement display position*1
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List of Quick Check Window Functions .16, p.17)

Check mark display

50% view/100% view (moiré reduction off)/full view*!
File name of image Check marks (p.17)

[¢ 2/15 IMG_0002.CR2 [3456 x 2304] Displaystheimage
in full screen*2

Check mark [ Clear 4—— Removes check

(O3 2 JI s J| marks(p.17)
(Previous ) ( MNext )

-
l 50% wview ‘ [Full screen'.]_

Switches between
displayed images

info... +— Displays the image

information window

| Rotate right | (p22)

Image rotation
(90 degree units)

Rotate left

(T

e

*1 You can select 50% view/100% view (moiré reduction off) by selecting
[Preferences] in the [Digital Photo Professional] menu and using
[Quick check tool display] in the [View settings] tab sheet. You can
also move the display position in the enlarged display by dragging the
image.

*2 To return to the normal screen, press the <esc> key.

)
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List of Edit Image Window Functions ©.1.p.33

Shows/hides grid*4
Enlargement ratio of displayed image

Shows/hides tool palette
Shows/hides thumbnail display area
Switches to main window

Image path and file name
Image rotation (90 degree units)

Switches between displayed images Batch conversion/saving

.103 | .80, p.81
(p ) " @ Digital Photo Prjpfessional File Edit View Affjustment Tools Window | Help = 4) |[Ved 3:18PM [3) (p ! p )
\ E Digital Photo Professional - [ MacOSX/J:|ers/canon/Pictures/Photo/xxxx_xx_xx/IMG_0003.CR2 ]
Toolbar
Shot settings B Tune.. )
‘_J?i(lurg Style LEJ‘
.[.Standard %) ( Browse... )
4 +— Tool palette
1o T e (p.107)
-10.0 8.0 -6.0 -40 -2.0 20 40
Thumbnail display area*3 e e ey
7 Linear
{Cudzlur T
Sharpness: e ——
iy Ao
— CMYK
- simulation
display
Information diSplay*Z {(1258, 1109) . 136, 145, 178 High quality RAW / Adabe RGB CMYK 7] (p74)

Display mode*>  Image color space*! and work

color space (p.65, p.74)

*4 You can set the grid spacing with [Grid pitch] in the [Preferences] (p.72).
*> The item selected in [Viewing and saving RAW images] (p.70) of the
[Preferences] window is displayed.

*1 RAW images are displayed with [RAW].

*2 Displays the coordinates of the cursor position and the RGB values
(8-bit conversion).

*3 Displays images selected in the main window. The image selected
here is enlarged and displayed on the right.

)
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List of Convert/Save One Image Window Functions s

Convert and save

Save As: DPP_00O1

| =

Types of image

File name

Save destination

JPEG compression rate*3

; : Where: | 7 Photo H
Type of image Extension
Exif-JPEG JPG File format
Exif-TIFF 8bit TIF : —— =
TIFF 16bit TIF Kind of file Exif-JPEG H
Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG mage qualty T @ 10
TIFF 16bit+Exif-JPEG | .TIF/.JPG _
Output setting _ i 1
_ Output resolution 350 dpi | Embed ICC profile
Resolution*1 |
Resize setting il ., % 1 ) ,
] Resize
. . Width Heigh Uni
Size changing*4 - = ) — '
3504 2336 _p_mﬂ _:
{ 3504 pixel ) {2336 pixel )

*1 The setting range is 1 to 60,000 dpi.

*2 Color space (p.65, p.74) information that is set in an image is attached

to an ICC profile.

Even if you remove the check mark from images that have been set to

f Logk azpectratio

J

{L‘ancelj} { Save )7

Embeds of ICC profiles*? (p.117)

—— Save

Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.65,
p.74), the ICC profiles are embedded automatically.

*3 The setting range is 1 to 10. The higher the numerical value, the higher

the image quality becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the
longer edge of an image and change its size.
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List of Trimming Window Functions 35092

Cancels all the trimming (aspect ratio) information

808 # 1/1 IMG_0D01.CR2 [3456 x 2304]

(1037 ,504 ) -> (3026, 1830) = { 1989 x 1326 ) [ 1.50] =

+— Full screen display/returns to normal screen

—_—
Full screen

( cear ) ( Resst 11— Revertsto the condition when the image was shot
) | Ratio of trimming range (you can also enter

numerical values if you have selected [Custom])*1

Upper left coordinates of trimmed range (you

can also enter numerical values)

Aspect ratio
3.00 - 2.00
>
o e =)
1037 - 504 8
idth: Height:
1989 . 1326 v)

( Cancel )( oK

)

Size of trimmed range (you can also enter
numerical values)

Copies the trimmed range and applies (pastes)
it to another image*2

Applies the copied trimming range to all other
images*?2

—— Level of opacity outside a trimmed range

—— Switches between displayed images*?

g

Trimming range

*1 If [Free] has been selected in the [Aspect ratio] list box, you can also
drag the borders of the trimmed range to change its range.

*2 Qperates when you have selected multiple images and the trimming
window is displayed.

Displays borders around a trimmed range

)
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List of Lens Aberration Correction Window Functions 9 .
£ Lens aberration correction - [IMG_1001.CR2] N
Contents at
a Glance
Basic
— Enlargement display section*1 CREEH
Advanced
i Operation
| Reverts to the condition when the
image was shot
Shooting distance information Advanced
Siider (p.60) Image Editing
' and Printing
— Peripheral illumination correction
J Processing
] ) ) Large Numbers
— Distortion correction of Images
m;t—' i — Chromatic aberration correction Editing
JPEG/TIFF
-~ )+ Corrects blue chromatic aberration Images
[ Color bt Color blur correction
Shows/hides position of
# Navigator enlargement display section Reference
J( ok )
| ‘ Index
Enlargement display position Corrects red chromatic Grid display
(Navigator display) aberration
*1 The area you clicked on the image (Enlargement display position) is @
displayed at 200%. —
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List of Copy Stamp Window Functions .61t p.6s p.94t0p.98)

Introduction

[# 1/2 IMG_0050.CR2 [3456 x 2304]
| 1oosvew | | Fuisizevew +—— FUIl SCreen display/returns to normal screen CErl S At
( aeeyDustDeiee e ———— Applies Dust Delete Data (p.61, p.94) a Glance
(Light) (Dark) )
eIk T — Types of dust to be erased (p.63, p.96)
~ ... .. Specifies the copy source (p.65, p.98) .
. . Basic
— Fix Copy souree position ——— Fjxes the copy source position (p.65, p.98) Operation
; [”g:::h = ]— Types of stamps (p.65, p.98)
Sets the size of the dust erasure range (p.63,
— p.96) or copy range (p.65, p.98) in arange of 5 Advanced
to 100 (in one pixel units) (you can also enter a Operation

numerical value)
Restores/redoes the image

Copies the dust erasure range or copy range and Advanced
applies (pastes) it to another image Image Editing
and Printing

Switches between displayed images*

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Set to 100% View to perform stamp operation. -_— 7

Index

* Operates when you have selected multiple images and the copy

stamp window is displayed. @ @
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List of Convert/Save Multiple Images Window (Batch Processing) Functions s

File names of images to be

batch saved

IMG_0001.CR2

IMG_0002.CR2
IMG_0003.CR2
IMG_0004.CR2
IMG_0005.CR2
IMG_0006.CR2
IMG_0007.CR2
IMG_0008.CR2
IMG_0003.CR2
IMG_0010.CR2
IMG_0011.CR2
IMG_0012.CR2
IMG_0013.CR2
IMG_0014.CR2

IMG_0015.CR2
) S ——

Batch settings

[ Save folder

MacO&X /Users/canon/Documents

| SIS
Browse... ]

File format

Exif-JPEC

4(Kind of file

.:D

Image quality

.y

——— Save destination

— JPEG compression rate*3

Output setting

Output resolution

350 dpi

IZT Embed ICC profile

( Resize setting
" Resize
Width
3456 x
( 3456 pixel )

Height

\.

2304

{ 2304 pixel)

Resolution*1
— Embeds ICC profiles*2 (p.117)

( File name.

Types of image

Type of image Extension
Exif-JPEG JPG
Exif-TIFF 8bit TIF
TIFF 16bit TIF

Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG

TIFF 16bit+Exif-JPEG | .TIF/.JPG

*1 The setting range is 1 to 60,000 dpi.

*2 Color space (p.65, p.74) information that is set in an image is attached

to an ICC profile.

Even if you remove the check mark from images that have been set to
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.65,

. Current file name
String

@ New file name

.

| Save sequence number

i String Sequence number
DPP_ 0001
Ex3 DPP_ODOL.)PC, DPP_00DZ. PG

Size changing*4

File name

(_Image transfer settings
! [} Open image using software

= i

Browse...

J

’ Convert RAW images only ‘ /

Cancel

‘ ( Execute }

Batch transfer to other image
editing software (p.81)

Images to be converted are limited to RAW images*>

p.74), the ICC profiles are embedded automatically.

Save

*3 The setting range is 1 to 10. The higher the numerical value, the higher

the image quality becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the

longer edge of an image and change its size.
*5 Appears when you click the [Batch process] button (p.103, p.110)

without an image selected in the main window or the edit image
window. To convert RAW images only, instead of clicking the [Execute]
button, click this button.
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)

List of Rename Window Functions 2 _
Introduction
MacOSX /Users/canon/Pictures/Photo/xxxx_xx_XX
Contents at
( File Name Extension ) . a Glance
DPP 3 Shooting Date/Time 3 Sequence number B Do not change B Sets the new file name
\ J
( Basic Settings - dea o s [ Farmagsawings 0 i m )
o o Sequence number K
Order in which Images are sorted %) Fit to main window 0001 _| Save sequence number Operation
" File Name
¢ " shootin Date/Time : + . .
=S : P DT : Sets the format of information
Check mark to apply the same ———H ¥ e e e o Month Day Year ") in the file name Advanced
name to RAW images and JPEG ( __| Copy & Rename - Browse.. ) MM-DD-YY 3 Operation
ImageS recorded Slmu|taneOUS|y MacOSX /Users/canon /Desktop @Inser‘t underbar
Check mark to copy the images 4 . TN . ) Advanced
Click the [Browse] button and set Original File Modified File Name Ir;naggﬁgt'ithng
the save destination IMG_0001.CR2 DPP_09-13-06_0001.CR2 ! 9
IMG_0001JPG H |DPP_09-13-06.0002.JPG U
IMG_0002.CR2 IDPP_OQ—IS—UG_OODS.CRZ Processing
— i Lasge mbers
IMG_0003 JPG — DPP_09-13-06_0006.JPC of Images
IMG_0004.CR2 DPP_09-12-06_0007.CR2
IMG_0004 JPG DPP_09-12-06_0008.JPG Editing
IMG_0005.CR2 DPP_09-13-06_0009.CR2
IMG_0005 JPG - DPP_09-13-06_0010.JPG = JPEG/TIFF
—— = N — ) < Images
( Cancel ) G-Er.ecm:e)

Reference

Index

Q0
)
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Glossary
RAW image

EOS DIGITAL camera RAW images are recorded in an uncompressed
14bit or 12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
you view on a monitor and the color of an image you have printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

|ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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) ) ) Introduction
Color space CMYK simulation profiles
A color space is the reproducible color range (color gamut A profile that simulates colors when printing in a CMYK environment
characteristics). DPP supports the following five kinds of color space. (printing machine, etc.). With DPP, you can simulate color with four Contents at
sRGB : Standard color space for Windows. Widely used for types of profile. a Glance
the standard color space of monitors, digital Euro Standard : Profile normally used for book printing in
cameras, and scanners. Europe, suitable for simulation of standard .
Adobe RGB : A wider color space than sRGB. Mainly used for European printing. Basic
printing for business purposes. JMPA : Profile normally used for book printing, etc. in R
Apple RGB : Standard color space for Macintosh. A slightly Japan, suitable for simulation of magazine
wider color space than SRGB. advertising standard color printing. Advanced
ColorMatch RGB : A slightly wider color space than sRGB. Mainly U.S.Web Coated : Profile normally used for book printing in Operation
used for printing for business purposes. North America, suitable for simulation of
Wide Gamut RGB : A wider color space than Adobe RGB. North American standard printing.
Refer to the color chart below for the color area of each color space. JapanColor2001 type3 : Profile becoming a standard in the Japanese Advanced
printing industry, suitable for simulation of ";‘naggﬁgt'it;]”gg
Color chart of color spaces compatible with DPP JapanColor standard printing.
Processing
Y 0 .
Rendering intent o images
Rendering intents are color conversion methods when printing an image.
The conversion method of each rendering intent is shown below. Editing
Perceptual : Before and after conversion, all colors are JPEG/TIFF
Color range that can be converted to maintain the relationship between Images
seen by the human eye colors. Even where colors slightly change, you
can print a natural-looking image which has
maintained color harmony. However, Reference
depending on the image, the saturation may
change overall.
Relative Colorimetric : There will not be much conversion to colors |
. s . ndex
which are similar before and after conversion,
x but colors which are not similar are converted
appropriately. Because there are little changes
Gamma White point to similar colors which comprise most of an
value (color temp.) image, you can print a natural-looking image in @ @
— | SRGB 2.2 6500K(D65) which the saturation has not changed greatly.
[ Adobe RGB 2.2 6500K(D65) However, depending on the image, there are
............ Apple RGB 1.8 6500K (D65) cases where the overall tone of an image
————- ColorMatch RGB 1.8 5000K(D50) cha_nges somewhat as colors which are not
______ Wide Gamut RGB 292 5000K(D50) similar and hlghllghts Change. 118
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A

AdJUSE JPEG IMAQGES ... ittt eeeeeeeeeeeeeeeeeeeeenneeeeees 84

AdjUSt RAW IMAQGES....uuuuiiuriiiiiiiiiiiriiiniirisistssrsssssssessassessssssssseesrnnrnre. 23

AJUSE TIFF TMAQJES. ... uuueiiiiiiiiiiiiiiitiiitiitiiieeeiieeieeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeees 84

Adjusting (JPEG or TIFF Image)
Automatic Adjustment (Tone Curve ASSISt).......ccooeeeieeieciiiieieenns 85
BIIGNINESS ...ttt 86
Click Whit€ BalanCe .......covuiiiiiiiiieeei e 87
(O70] 011 7= 1S R 86
DYNaMIC RANGE .....iviiiiiiieeeieeeeeeeeeeeee e 90
i 10 L= 88
RGB TOOI PAIELE ....eeeeeeeeeee e 84, 107
=100 [ = 11T ] o I 88
S =T 0] LSS PPPP 88
Tone Curve AdjUSIMENT......ccooiiei e 89

Adjusting (RAW image)
APPLY AdJUSTMENTS ... 78
Automatic Adjustment (Tone Curve ASSISt).......ccoeeeeieeiieeiieiiiennns 30
BIIGNINESS .vvviieiiiiiiieeeeee ettt ea e 24
Click White BalanCe .........cooeiiviiiiiiie e ee e 26
(OF0] (o] g Y= 1 (U] 7= 110 ] o 27
(7] (o g =10 0] 0 1=T 7= (0[S SRR 52
(©F0] (o i 1] £ [T T 27
(OF0] [0 YA g T<T=] T 52
(O] 11 =1 S 27
(070 o)A AV 18111 41T o £ 78
DyNamiC RANQE.......ccuuuiiiiii e 53
[ L] g 1 (=T A 28
1Y/ Lo 1 a1 (] 1 1[I 28
Personal White BalanCe ...........oovveiiiiiiiiii e 79
PICIUIE SEYIE e 24
Picture Style File ......uvveiiie e 53
RAW TOOI PaAlBte ...uviiieeiee e 107
SaVE AGJUSTMENLES ....oiiiiiiieiiiiieeeie e 78
SNAIMPNESS .o 29
Tone Curve AdjUSIMENT........ooiiiiiiiiiieeee e 54
ToninNg EffeCt ..o 28
LN Y01 2= 11T 1 12,107, 108
WHItE BaAlANCE . ccvniieeiie e 25

Adjustment Contents (RECIPE)........uuvvurreerrreriirreeeererereeeeeeereeaneeeees 77,117
AdODE RGB ... 118
APPIE RGBh...cciiiiiiieieeeeeeee ettt 118
AITaNgE IMAGES ..ot aeaaeeees 18, 19
Automatic Adjustment (Tone Curve ASSISt) .......ccvvvevveeiiieiiieiieneen, 30, 85
Automatic Dust Erasure Processing.......cccccveeeveeveeeeeeencens. 61, 62, 94, 95
B
Batch Apply White Balance to Images (Personal White Balance)....... 79
Batch Change the File Name of Images.........ccccccevviiiiiiiiiiieeieeeiie 82
Batch Convert/Save Images (Batch Process) .......ccccccceeeevveeeeevveeinnnnnn, 80
Batch Process (Batch Save JPEG and TIFF Images)................. 80, 115
Batch Process of Multiple Images
Change File NamMe ........coooiiiiiiiiie e 82
Convert/Save (BatCh ProCeSS).........uuuvvvvvrvveerrrerienireerrnnrnennns. 80, 115
Personal White BalanCe.............cccoooiiiiiiiiiiiiiiiiiieee e 79
RECIPE DALA ....covvvviiiiiiiiiiiiiieee 77
L= 105 (= R 81
Batch Settings WIiNAOW..........ccoooiiiiiiiiieees 80, 81, 115
Batch Transfer IMages .........ccoceeuuuiiuiiiiiiiiiiiiiiiiiiiievvvere e 81
Batch Transfer Images to Image Editing Software...............ccccoeeuvinee. 81
Before/After Comparison DiSplay .............eeeuvevieeiireviiiiieiieeeiieeeeeeeeeeeen 49
DIt NUMDET ... e e e e 117
BOOKMArK ... a7
BIIgNINESS ... 24, 86
C
Change File Name.........cooooiiiii s 82
Changing the File Name of Images in the Order in the Main Window. 82
Check Mark ..o, 17,18, 105, 109
Chromatic Aberration COrreCtion ..........ccoeeeeieeeieeeeeeeecees 59
Chrominance Noise Reduction (JPEG, TIFF Images).......ccccccceeeeennnn. 91
Chrominance Noise Reduction (RAW IMages) .........ccccvvvvevveeiniiiinnnn. 56
Click White BalanCe..........cooooviiiiiiii 26, 87
CMYK SIMUIALION +.ieeeiiii ettt e e 74,75, 118
Collection WINGOW ........cuuiiiiieeeeiiiiiiiiiee e 6, 33, 104
(670 (o] gl =] [V g 014 =Tox i o] o S 59
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(0] 0] g ©1 o F- T SR PPTPPPPPRPR 118
Color Management (Color Matching)..........ooooeeiieiieiiiieeeeeeeee s 117
Color Setting of the Monitor (Profiles) .........cccccvveviieiiviiieeiiieiieeee, 74
Color Setting of the Printer (Profiles)........ccccovvvieeiiiiiiiiiinnnen, 74,75
COlOr SPACE.....ci ittt 118
ICC Profiles ..o 117
Color Management (Preferences)..........cvveviiiiiieiiieeeeeiiiiiieeeee e 74
Color SAtUratioN .......cooviiieeieee e 27
Color Setting of the Monitor (Profiles).........c.occocvviiiiiiiiiiiiiiiceeee 74
Color Setting of the Printer (Profiles) .........cccvvvviiieiiiiieeeeeein, 74,75
COlON SPACE ...t 118
AdObEe RGB ... 118
APPIE RGB ..o 118
Color Space Setting for Each Image ..............eeeveeieeiieeiiiiiieeiiennenn. 65
(7] (o 141V =1 (o1 I 2 L €1 = SR 118
Default Setting of Color Space .......cccccvvvvvvvviiiiii 74
SRGB ... s 118
Wide Gamut RGB ... 118
Color Space Setting for Each Image..........cccooeeeeiii, 65
Color TEMPEIAIUIE.....cceeeeeiieeieeeeeee e, 52
(O] (o] g 1o 1= 2R 27
COlOr WNEEI ... 52
ColorMatCh RGB........ooiiiiiiieee 118
Compatible Cameras with the Lens Aberration Correction Function.. 57
Compatible Lenses with the Lens Aberration Correction Function..... 58
Contact Sheet Printing (Printing a Thumbnail List)............................. 67
CONTIAST . et 27, 86
Convert to JPEG or TIFF Image and Save................... 38, 80, 111, 115
Convert/save One Image Window .......ccccooeevvvvviviiininneeeeceeeeeinnnn, 38, 111
Copy Stamp (Image COrrection) ...........eeeeeeeriiiiiiiieeee e 65, 98
Copy Stamp WINAOW ......cceeviieiiiiiiiiiiiiic e 61, 63, 94, 96, 114
Copying and Pasting (Applying) RECIPES.........cccuvviiiiieiiiiiiiiiiieeeeeee 78
Correct Images (Copy Stamp Function) .........cceuveeeinnieeeereeeninnnnnn. 65, 98
Creating @ FOIUET ... 45
D
Default Noise Reduction Settings ..........cccuvvveiiieeiiiiiiiiiieeeee e 73

Default Setting of COIOr SPACE .........uvvvviiviiiiiiiiiiiiiieiiiiiieeree e 74
Delete IMAGES ....ccoiiiiiieie et 45
Deleting
Delete IMagesS.......oovviiiiiiiieee 45
Delete the Software ..., 102
Deleting DPP (Uninstalling) ........cccoooeiiiiieiiicccccc v 102
Detailed Setting Printing (Printing with Shooting Information)............. 66
Display
Before/After Comparison Display ..., 49
Enlarged Display (Edit WINdOW) ... 11, 106
Enlarged Display (Quick Check Window) ............ccccevveeeennnns 16, 109
Shooting Information Display ...........cceeevvveiviiiiiiiiiiiiieiiieiieeee, 10,21
Single IMage DiSPIAY ........evvveiveiiieiiieiiieiieeieeeeeeeeeeee e eeeees 20
Synchronize Edit WINAOW ............ciiiiiiiiiiieeeiin e 50
Thumbnail Display (Main Window)..........cccccceeiiiiiiinniinnennns 10, 103
Thumbnail Display and Enlarged Display
(Edit Image WiNOW) .........ccuieiiiieeeeeiiiieeeeee e 31, 110
DIStOrtion COMTECTION ... .uveiie ittt 59
Downloading an Image to Your COMPULET .........ccoviiiiiiriiiieeeiiiiiiieeee 7
Downloading Images from a Camera ...........cccceoeeeeeiiiiiiiece e 7
Downloading Images from a Card Reader............cccccovvvvvvieeeeeennnns 9
Downloading IMageS .........uuuuuuuuiiiiiiiiiiiiiiiiiiiiiirreraebareraeeereee s e 7
Downloading Images from a Camera..........ccuueeeeeeeiiiiiiniiiiieee e 7
Downloading Images from a Card Reader ...........cccccccceeevieeeieveeeiiinnnn. 9
DUSEt DEIELE DAt ....ceveiiieiieee e 61, 62, 94, 95
Dust Erasure Processing
Automatic Dust Erasure Processing ........ccoeeeeeeeiesennnnnnnnnnnnnns 61, 94
Image Correction (Copy Stamp Function) .........cccccceevviivinnnen. 65, 98
Manual Dust Erasure (Repair FUnction) .........cccceoveeevvveeninnnnnn. 63, 96
DYyNamiC RANQE ......coiiieieieieeiiie et e e e e e e e 53, 90
E
Edit IMage WINAOW...........uuuuiiiiiiiiiiiiiiiiieiiieeieeieeeeeeeeeeeeeeeeeeeeeeaeees 31, 110
Lt [ AR ATAT o [0 ) AT 11, 106
EditiNg.....ccooiiieee e - Adjusting
Enlarged Display (Edit WINAOW) ...........eevueiiieiiiiiiiiiiiiiieeeeieeeeeeeee 11, 106
Enlarged Display (Quick Check WINdOW).............uvvvvvvieiinevvnnireerennne. 109
L@ S0 111 S SEER S 7
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F
False Color REAUCTION ....ccviiee et 70, 71
Filter EffeCt.......cooiiiii i 28
[00] (o [T gYAVA o o [0, AP TPTPTPT 6, 103
G
General Settings (Preferences) ..., 70
H
H I e Cover
Highlight Area Warning Indicator ............cccoevviieiiiiiiiiiii e, 51
HUB oo e 88
I
ICC PrOfilES ... ittt eeeeeas 117
Image Frame Information (Image Marks) ..........cccccuveevivevveerieneeeennnnn, 105
Image Marks (Image Frame Information) ..........cccccccvveveiiieiinniinnnnn.. 105
Image Quality
Default Noise Reduction Settings..........ccovvvviiiiiieiiiiiiieeeee 73
False Color RedUCHION ..........uueiiiiiiiiiiiiiieieeeeeeeeeeeeeeeeeeeee e 70,71
Improve the Quality of an Image (Main Window) ..........cccccouveeeeen. 21
Noise Reduction of a JPEG Image (Chrominance)..................... 91
Noise Reduction of a RAW Image (Luminance, Chrominance) ... 56
View and Save a RAW IMage .........cvvveviiieeieieeiiiiiiiiseeeeeseeeennns 70, 71
Image Shooting Information DiSplay ..............eeeeeiieiiiieiiiiiiiiiieeenene. 10, 21
Improve the Quality of an Image (Main Window)..........cccccoeviivvviennn. 21
J
JPEG IMaAGE. ..o eeaaae 117
L
Lens Aberration COrreCtioN ..........cceevvvvieviiiiieis e e 57
Lens Aberration Correction Window .........cc.ovvviviiiieeiiieeeiieeeennn, 59, 113
I >V PP 27
Loading and Pasting (Applying) RECIPES .......ccovviiiiiiiiiiiiieeiiiiieeeee 78
Luminance Noise Reduction (RAW ImMages) ........cccccceeeiieeeeeeeeevvvnnnnnn. 56
M
Main WINAOW ... 10, 103
Manual Dust Erasure (Repair FUNCLION) .........ovveviiiiiiiiiiiiiiirieeeeeee, 63, 96

MONOCNIOME ...ttt 28
Filter EffeCt.. ..o 28
ToNING EffECt....coo o 28

Move Or COPY FOIAEIS ......uuiiiiiiiiiiiiiiiiiiiiii e 46

Move Or COPY IMAGES ......uuumuriiiiiiiiiiniiiirree e eeeeees 46

N

Noise Reduction (JPEG or TIFF IMage).......ccccvveeeeiiiiiiiiiiiieeeee e 91

Noise Reduction (RAW IMAQJE) .....uuurrrumiiiiiiiiiiiiiiiieeieeieeeeeeeeeee e 56

Noise Reduction of a JPEG Image (Chrominance)..........cccccccoevvnnnnee. 91

Noise Reduction of a RAW Image (Luminance, Chrominance) .......... 56

NR/LENS TOOI PAIELE ...ccccceeiiiiiiiiiieeee e 108

@)

Organize IMAGES .....cooiiuiiiieiiie ettt 45

Organizing IMagesS ....ccoooeiiiiiii e 45
(@Y= 1= T 0] (o = SRR 45
Delete IMAGES ......eeiiiieiiiiitiee et 45
Move or Copy FOIders........ccoooviiiii 46
MoVe OF COPY IMEAGES .....uuuiiiieeeii e 46
Register Folders as Bookmarks.............ccccooiiiiiiiiiiiieieiiee a7

P

Peripheral lllumination COorreCtion ............ccccvveiiieeiiiniiiiieeeee e 59

Personal White BalanCe ...............uuuuuiiiiiiiiiiiiiiiiiiiiieiiiieeeeeeeeeeeeeeeeeeeee 79

PICTUIE STYIE e 24

Picture Style File......ooo oo e 53

PreferenCeS . ... 70
(7o) (o] \V F=TaF=To [=1 o 1= o | A 74
GeNEral SEHHNGS . ...uuueeieiiiiiiiiiiiiitieiiiieieeeeeee e eeeeeeeeeees 70
TOOI PalEHe ... e 73
VIBW SEEINGS ..eveiiieiiiiiiiiiee et e e 72

Printing
Printing a Thumbnail List (Contact Sheet Printing) ...................... 67
Printing One Sheet of Paper..........occcvvviiiiiiiiiiiieees 14, 44
Printing Using Easy-PhotoPriNt..............ccccovviiiiiiiiiieeeeeiiieeen 42
Printing Using Easy-PhotoPrint EX..............ccccc, 39
Printing with a High-End Canon Printer ............ccceeeevieiiveevieviinnnnnn. 68
Printing with a Large-Format Canon Printer ..........ccoevvvvvvvvvnnnnnn. 69
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Printing with a Printer other than the Canon Printers................... 44
Printing with Canon Inkjet Printers ........ccccccccceeeiiie e, 39, 42
Printing with Easy-PhotoPrint Pro ............cccccevciiiiniiiinin, 68
Printing with Shooting Information (Detailed Setting Printing)...... 66
Rendering Intents when Using Easy-PhotoPrint .................... 74,75
Printing a Thumbnail List (Contact Sheet Printing) ..........ccovvvvvvvveene... 67
Printing One Sheet of Paper ... 14, 44
Printing Using Easy-PhOtOPTINt.............uuuuviiiiiiiiiiiiiiiieiiieiieneeeeveeeveeeeee 42
Printing Using Easy-PhotoPrint EX..........cccovveiiiiiciee 39
Printing with a High-End Canon Printer ............cccccvvvvvvveviveeeeieeeeeeeeee, 68
Printing with a Large-Format Canon Printer ............ccccccvvvveeeveeeeeeennnn. 69
Printing with a Printer other than the Canon Printers...........ccccccvvuo..... 44
Printing with Canon Inkjet Printers...............eevveeiiiiiieeiieeiiiiieeeeeee, 39, 42
Printing with Easy-PhotoPrint Pro...........cccuvvvvvvviiiiiieiiiieiieieeeeeeevveeeee 68
Printing with Shooting Information (Detailed Setting Printing) ............ 66
Q
QUICK CheCK WINAOW.....uuuiiiiiiiiiiieicee e 16, 109
QUITEING DPP e 14
R
AN YAV 1 0= T 1SS 117
RAW TOOI PAIEE ....ceviiieeeeee et a e 12, 107
Re-Adjusting an IMage ..........uvuiiiiieeieieeeice s e e e e e e e aenes 39, 99
RECIPE e 77, 117
RECIPE FilE .. e e 77
Re-Editing an IMage ........ccooiiiiiiiiiiiiieeeeee e 39, 99
Registering Folders as Bookmarks..........cccoooeevviviiiiiiii e, 47
RENAME WINAOW......ieeiiiieiee et e s 82, 116
Rendering Intent (Matching Method) .............evvvviviiiviiiiiiiiiiiiiiieeineee, 118
Rendering Intents when Using Easy-PhotoPrint .................... 74,75
Rendering Intents when Using Easy-PhotoPrint...........cccccceeeee. 74,75
Repair (Manual DUSt Erasure) ..............eeeeeeeeeeeieeieeeeieeieeeieeeeeeeeeen 63, 96
RGB TOOI PalETe .......uvviiiieiiiiiiiiieeeeeeeesce e 84, 107
Rotate Images.......ccoovvvvviiiiveeiie e 10, 23, 103, 104, 109, 110
S
SALUrALION. ...eiiiiii i 88

Save
Batch Convert/Save Images (Batch Process)...................... 80, 115
Convert to JPEG or TIFF Images and Save .........cccccceeeeee... 38, 111
SV Lttt ettt ettt et ettt e e e e e eees 37, 98
SAVE AS ittt ettt ettt e et e e e e e 37,98
Save JPEG or TIFF Image as a Separate Image ...........cccceeveeeens 99
View and Save RAW IMages .......ccooeeeeeieiieeiieeeees 70, 71
AV A S e e 37, 98
SaVING RECIPES...cco i 78
SeleCt IMAageS....cooo i, 10, 16, 31
Shadow Area Warning INdiCator............cooeeeiiiiiiiiiieeicces 51
SNAIPNESS ... 29, 88
Shooting Information Display............cccccoeiii 10,21
ShOMCUL KEYS . Cover
Single Image Display ..o 20
Single Image Display of RAW and JPEG Image .........cccoeeeeiieccccnnnnns 20
Sorting Images (Check Marks) ..., 17,18
] T = SRR 118
Starting UP DPP ... 6
SUPPOrted IMAGES ... 3
Synchronization (Edit WiNndOW)............cooooiiiiiii e, 50
Synchronize Edit WINAOWS .........ooiiiiiiiieeiiieeee e 50
SYNChroNiZe IMAgES ......coooe i 50
SyStemM REQUITEMENTS ......oiiiiiiiiiiiiiiiie et 3
T
Thumbnail Display (Main Window) ..........cccovvuviiiiiiieeeeeeeeeeiiinnnn 10, 103
Change the DISPlay.........coouuiuiiiiiiiieeiiie e 10
Thumbnail Display and Enlarged Display (Edit Image Window) ......... 31
Thumbnail Display of Images (Main Window) ..............cccooeeieeiiiiieens 10
Change the DISPlay..........couiiuiiiiiiiiee e 10
LI 11T T T 117
TONE CUINVE ... et e s 117
Tone Curve AdJUSTMENT........cooiiiiee e 54, 89
Tone Curve Assist (Automatic Adjustment)..........cccceeevvvivinneneeenn. 30, 85
TONING EffECT ... 28

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

00
©

122



Tool Palette

NR/Lens TOOl PalEtte .........eeueeiiiiiiiiiiiiiiiiiieiieeeeeeeeeeee e 108
RAW TOOI Palette.....uvuiiieiiciiieicee e 107
RGB TOOI PAIELLE ....covieeeiiiiiiiiiiiiee e 107
Tool Palette (PreferenCes) ........uuvveiieeeiiiiiiiiiieiieiiieeieee et 73
Transfer
Batch Transfer Images to Image Editing Software...................... 81
Transfer an Image to Photoshop...........cccceeiviiiiiiiiecccii e, 65
Transfer an Image to PhotoShop ... 65
THAMMING @N IMAJE ...evvviiiieiiieiiieeeeieieeeiee e e eeeeeeeeeeeeees 35, 92
TrmMMING WINAOW ......evviiiiiiiiiiiiiiiiiiiiiiiieiieeeeeeeeeeeeeeeeeeeeeeeeee 35,92, 112
\%
View Settings (PreferenCes) .........uuvvvvviiriiiiiiiiiiiiiiiriieeeeereissseeeseeenneeen 72
W
WHhite BalanCe.........uuiiiiiiiiiiece e e 25
Click White BalanCe .............uuuuuiiuiiiiiiiiiiieiiiieiiiieieeeeeeeeeeeeeeeeee 26, 87
COlOr TEMPEIALUIE ....eeeiiieiiiieeeee e 52
COlOr WREEI.....eiiiiiiiiiiiiii et eeees 52
Personal White BalanCe .............coeieeiiiiiiiiiiiiici et 79
Wide GamUEt RGB .......uuiiiiiiiiiiiiiiiiieeee ettt e e 118
WOTK COlOr SPACE......eeiiiiieiiiitie et 65

About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments

Macintosh is a trademark of Apple Inc., registered in the United States
and other countries.
Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.

@ Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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